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Общие сведения

Задняя сторона
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Общие сведения

yy В этом руководстве кнопки и прочие органы управления обозначаются следующими номерами и названиями.

 Колесо изменения высоты тона (BENDER)

 Колесо модуляции (MODULATION)

 Ручки K1 – K4

 Ползунок S1

 Ползунок S2

 Ползунок S3

 Ползунок S4

 Ползунок S5

 Ползунок S6

 Выключатель питания 

 Регулятор громкости (VOLUME)

 Кнопка «SYS SETTING» [Системные настройки]

 Кнопка «ARPEGGIO» [Арпеджио]

 Кнопка «PIANO» [Фортепиано]

 Кнопка «ELEC PIANO» [Электропиано]

 Кнопка «ORGAN» [Орган]

 Кнопка «STRING/BRASS»  
[Струнные/Медные духовые инструменты]

 Кнопка «GUITAR/BASS» [Гитара/Бас]

 Кнопка «SYNTH/VARIOUS»  
[Синтезированные тембры/Разные тембры]

 Кнопка «DRUMS» [Ударные инструменты]

 Кнопка «HEX LAYER»  
[Тембры с наложением тональных вариаций]

 Кнопка «EFFECT» [Эффект], «SONG» [Композиция]

 Кнопка «DSP» [DSP-эффекты], «REW» [Прокрутка назад]

 Кнопка «SYSTEM» [Системные эффекты],  
«FF» [Прокрутка вперед]

 Кнопка «MASTER» [Мастер-эффекты], «PAUSE» [Пауза]

 Кнопка «PHRASE» [Фраза]

 Кнопка «START/STOP» [Запуск/Остановка]

 Кнопка «RECORD» [Запись]

 Кнопка «TEMPO» [Темп], «TAP» [Отстукивание темпа]

 Кнопки «ZONE/PART/STEP/TRACK»  
[Зона/Партия/Шаг/Дорожка], +/-

Дисплей

 Кнопка «BANK» [Банк], «INITIALIZE» [Инициализация]

 Кнопка 0, «DELETE» [Удаление]

 Кнопка 1, «INSERT» [Вставка]

 Кнопка 2

 Кнопка 3

 Кнопка 4

 Кнопка «EXIT» [Выход]

 Кнопка 5, 

 Кнопка 6, 

 Кнопка 7, 

 Кнопка 8, 

 Кнопка 9, «ENTER» [Ввод]

 Кнопка «NUM KEY» [Цифровые кнопки]

 Кнопки «-/NO» [Нет], «+/YES» [Да]

 Кнопка «EDIT» [Редактирование]

 Кнопка «WRITE» [Запись]

 Кнопка «AUDIO RECORDING» [Звукозапись],  
«MEDIA» [Носитель данных]

 Порт для запоминающего USB-устройства

 Порт USB

 Разъемы «PEDAL» [Педаль] – «DAMPER/PEDAL 1»  
[Демпферная педаль/педаль 1], «PEDAL 2» [Педаль 2]

 Разъемы «MIDI» – «OUT/THRU» [Выход/Сквозной], «IN» [Вход]

 Разъемы «LINE OUT» [Линейный выход] – «R» [П],  
«L/MONO» [Л/Моно]

 Разъем «DC 12V» [12 В постоянного тока]

 Разъемы «LINE IN» [Линейный вход] – «R» [П],  
«L/MONO» [Л/Моно]

 Разъемы «PHONES» [Наушники]

 Разъем «AUDIO IN» [Аудиовход]
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Общие сведения

Прочтите отдельное 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ 
(Основные сведения)!

Перед первым использованием этого цифрового пиа-
нино обязательно прочтите отдельное РУКОВОДСТВО 
ПОЛЬЗОВАТЕЛЯ (Основные сведения) с целью озна-
комления с основными операциями.

Мера предосторожности при 
включении питания!

Убедитесь, что при нажатии кнопки   для включения 
питания не нажата ни одна из педалей (подключенных 
к разъемам «PEDAL 1» и/или «PEDAL 2»). Включение 
питания при нажатой педали может привести к наруше-
нию работы эффектов.
yy При возникновении подобных проблем выключите 
питание, убедитесь, что педаль не нажата, и снова 
включите питание.

Сообщение «WriteError»  
[Ошибка записи]

Если при попытке сохранения данных в памяти циф-
рового пианино на дисплее появится сообщение 
«WriteError» (ошибка записи данных), запишите отобра-
жаемый в этом сообщении цифровой код. Код указыва-
ет причину ошибки и действие по ее исправлению.

Код Причина Действие

-4 Низкий уровень 
заряда батареи.

yy Подсоедините адаптер 
переменного тока.

yy Замените батареи.

-1, -2, 
-3, -5, -6

Сбой записи 
данных.

yy Попробуйте сохранить 
данные еще раз.

yy Восстановите перво-
начальные заводские 
настройки цифрового 
пианино.

Внимание!
При восстановлении 
первоначальных завод-
ских настроек цифрового 
пианино ваши пользо-
вательские данные будут 
удалены.
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Общие сведения

Взаимосвязь между зонами, партиями, приемным MIDI-каналом и тембрами

Тембры данного цифрового пианино состоят из 16 приведенных ниже партий, а также партий, вводимых с внешних 
устройств.

�� Взаимосвязь между зонами, партиями и тембрами

* �О зонах и партиях зон 
Нажатия клавиш, педалей, кнопок и другие операции не только влияют на тембры цифрового пианино, но также 
передаются в качестве MIDI-данных и влияют на любое подключенное к цифровому пианино внешнее устройство 
(электронный музыкальный инструмент или компьютер). По этой причине области настройки параметров, назы-
ваемые «зонами», используются для задания общих настроек для внутреннего и внешнего использования. Партии 
встроенного источника звука цифрового пианино называются «партиями зон». Например, если вы выберете тембр 
для зоны 2 цифрового пианино, этот тембр будет использоваться для зоны 2 встроенного источника звука и для 
партии, соответствующей MIDI-каналу 2 внешнего устройства.
yy При желании вы можете изменить взаимосвязь между зонами и каналами передачи MIDI-данных (стр. 31).

Вы можете играть на инструменте, используя четыре тембра одновременно. Вы также можете использовать «сцени-
ческие настройки» для регистрации установок тембра, секвенсора фраз и других параметров цифрового пианино для 
их быстрого и простого вызова во время исполнения.

Встроенный источник звука  
цифрового пианино

Внешнее устройство

Название 
партии

Номер 
партии

Действие Прием MIDI-данных 
с внешнего источника 

(стр. 39)

Песенный 
секвенсорФортепиано

Мелодические 
тембры

Тембры ударных 
инструментов

Hex 
Layer

Партия 1 
зоны*

01

Партия 2 
зоны

02

Партия 3 
зоны

03
— —

Партия 4 
зоны

04

--- 05–16 —

Партия  
внешнего 
устройства

—
—
Звук, подаваемый на входы  (LINE IN R, L/MONO) и  (AUDIO IN) на задней стороне 
цифрового пианино (стр. 36).

Партия 1 зоны Партия 2 зоны Партия 3 зоны Партия 4 зоны

(MIDI-канал 1) (MIDI-канал 2) (MIDI-канал 3) (MIDI-канал 4)

Настройка  
зоны 1

Настройка  
зоны 2

Настройка  
зоны 3

Настройка  
зоны 4
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Схема расположения данных
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Общие сведения

При использовании встроенного источника звука можно выполнять различные виды редактирования для создания 
звуков путем выбора DSP-эффектов, настройки параметров DSP-эффектов, редактирования тембров и т.д. Сигналы, 
получаемые в процессе создания тембра, собираются вместе, а затем подаются на выход через эквалайзеры, позволя-
ющие выполнять регулировку с использованием стандартных мастер-эффектов.

*1 �«Панорамирование перед DSP» может использоваться только, когда выбрано положение панорамирования DSP «Перед».
*2 �«Панорамирование после DSP» может использоваться только, когда выбрано положение панорамирования DSP «После».
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Общие сведения

Управление звуками

Вы можете использовать органы управления (педали, 
колеса, ручки и ползунки) для моментального измене-
ния высоты и громкости звуков, огибающей и других 
параметров во время исполнения (стр. 34).
yy На один орган управления могут быть назначены два 
целевых параметра. Например, задание приведенных 
ниже настроек позволит изменять баланс между слоя-
ми при помощи одного ползунка.

1) �Выберите «Громкость слоя 1» в качестве целевого 
параметра 1 ползунка 1 (стр. 35) и задайте мини-
мальное значение (Min Value) «0» и максимальное 
значение (Max Value) «127».

2) �Выберите «Громкость слоя 2» в качестве целевого 
параметра 2 ползунка 1 (стр. 35) и задайте мини-
мальное значение (Min Value) «127» и максимальное 
значение (Max Value) «0».

Использование педали

Вы можете настроить педаль таким образом, чтобы при 
ее нажатии продлялось звучание нот, применялся эф-
фект смягчения или изменялись настройки параметров, 
назначенных на педаль.
yy Педаль может быть настроена таким образом, чтобы 
ее нажатие/отпускание вызывало постепенное увели-
чение или уменьшение громкости звука. Для получе-
ния более подробной информации смотрите пункты 
«On Rate» и «Off Rate» (стр. 35).

yy Вы можете задать применяемый эффект, выбрав 
следующие установки в редактируемых параметрах 
сценических настроек:

Pedal1-2 Edit > Ent. Более подробная информация при-
ведена на стр. 35.

Использование колеса изменения высоты тона

Колесо  (BENDER) можно настроить таким образом, 
чтобы при вращении оно плавно повышало или пони-
жало высоту звуков.

yy Вращение колеса  (BENDER) может изменять высо-
ту звуков только в пределах определенного диапазона.

yy Вы можете настроить диапазон изменения высоты тона 
для колеса  (BENDER), задав следующие установки 
в редактируемых параметрах сценических настроек: 
«Bend Range Down», «Bend Range Up» (стр. 32).

Использование колеса модуляции,  
ручек и ползунков

Колесо  (MODULATION), ручки  (K1 – K4) и пол-
зунки  (S1) –  (S6) могут быть использованы для 
регулировки громкости, эффектов, составляющих эле-
ментов тембров и других параметров.

yy Вы можете задать эффект, назначаемый на каждый 
из этих органов управления, с использованием приве-
денных ниже редактируемых параметров сценических 
настроек. Более подробная информация приведена 
на стр. 35. 

 (MODULATION): Modulation Edit > Ent 
 (K1 - K4): Knob1-4 Edit > Ent 
-  (S1 - S6): Slider1-6 Edit > Ent
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Операции, общие для всех режимов

Использование ручек для ввода 
данных

При выполнении операций на экране редактирования 
и задании системных настроек вы можете использовать 
ручки для перемещения курсора по экрану и для ввода 
цифр, значений и т.д.

Как перемещать курсор

1.	 Вращайте ручку  (K1).

Как ввести цифру, значение или букву

1.	 Вращайте ручку  (K2).

yy На экране пошагового редактирования арпеджио 
(см. раздел «Редактирование арпеджио» на стр. 
25) четыре ручки управляют показанными ниже 
настройками.

yy В режиме песенного секвенсора четыре ручки 
соответствуют следующим настройкам.
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Использование встроенных тембров

Вы можете использовать процедуры редактирования, 
описанные в данной главе, для редактирования тембров 
и применения к ним желаемых эффектов. После завер-
шения редактирования тембра вы можете присвоить ему 
название и сохранить его в качестве пользовательского 
тембра.
yy Для получения информации о редактировании тем-
бров смотрите раздел «Как отредактировать тембр» 
(стр. 10).

yy Для получения информации о применении эффекта 
(DSP и/или системного эффекта) к тембру смотрите 
раздел «Применение эффектов к нотам» (стр. 18).

yy Для изменения эффектов и/или функций, назначен-
ных на колеса, ручки и ползунки, смотрите главу «Ис-
пользование сценических настроек (Учебное руковод-
ство)» (стр. 31).

Как отредактировать тембр

1.	 Задайте номер тембра, который вы хотите отредакти-
ровать.

2.	 Нажмите кнопку  (EDIT)
На дисплее отобразится экран редактирования.

3.	 При помощи кнопок  ( ) и  ( ) выберите «Tone», 
а затем нажмите кнопку  (ENTER).

4.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( ) 
выберите пункт.
yy Если на дисплее отображается индикация 
«>ENT», это означает, что для данной операции 
редактирования имеются другие пункты на-
стройки, помимо отображаемых. В этом случае 
нажатием кнопки  (ENTER) вы можете перейти 
к следующей странице настроек.

yy Отображаемые на экране редактирования пун-
кты настройки зависят от выбранного тембра.

yy Для получения информации о параметрах, 
которые могут быть отредактированы, смотрите 
объяснения, касающиеся каждой категории тем-
бров, приведенные в таблицах «Редактируемые 
параметры мелодических тембров» (стр. 11) – 
«Редактируемые параметры тембров Hex Layer» 
(стр. 14).

5.	 Измените параметры по желанию.

6.	 После завершения редактирования нажмите кнопку  
(EXIT).
yy Нажмите кнопку  (EXIT) требуемое число раз, 
чтобы вернуться к экрану, отображаемому до на-
чала редактирования.

Как изменить название тембра

1.	 Выполните шаги 1 – 3 процедуры, приведенной выше 
в разделе «Как отредактировать тембр».

2.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( ) 
выберите пункт «NameEdit», а затем нажмите кнопку  
(ENTER).

3.	 Измените название.

4.	 После завершения редактирования нажмите кнопку  
(EXIT).
yy Нажмите кнопку  (EXIT) требуемое число раз, 
чтобы вернуться к экрану, отображаемому до на-
чала редактирования.
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Использование встроенных тембров

Редактируемые параметры

yy Затененные ячейки указывают группу, состоящую из нескольких пунктов настройки. Нажатие кнопки  (ENTER) 
отображает пункты настройки данной группы.

�� Редактируемые параметры мелодических тембров

Индикация 
на дисплее

Описание Установки

Pitch >Ent Огибающая высоты звука. Редактируемые параметры в этой группе влияют на вы-
соту нот.
yy Приведенный ниже рисунок также применим к огибающей фильтра, усилителя 

и другим огибающим. Что касается огибающей высоты звука, высота звука соот-
ветствует вертикальной оси (Уровень).

yy Что касается тембра Hex Layer, время спада может быть разделено на три части, 
а время затухания может быть разделено на две части и отредактировано.

yy При достижении уровня спада 3 при нажатой клавише во время отпускания 
клавиши осуществляется моментальный переход к уровню затухания 1 без за-
держки.

yy Диапазоны настройки указанных ниже параметров представляют собой относи-
тельные изменения (по отношению к предустановкам тембра) в случае мелоди-
ческих тембров и тембров ударных инструментов. При редактировании тембра 
Hex Layer диапазоны настройки представляют собой абсолютные изменения, не 
имеющие отношения к предустановкам тембра. 
- Время и уровень каждой огибающей 
- Скорость, глубина, задержка, время достижения максимального эффекта, 
глубина низкочастотной модуляции (стр. 12)

IL: Начальный уровень
AT: Время атаки
AL: Уровень атаки
DT: Время спада
(DT1: Время спада 1)
(DT2: Время спада 2)
(DT3: Время спада 3)
DL: Уровень спада
(DL1: Уровень спада 1)
(DL2: Уровень спада 2)
(DL3: Уровень спада 3)

RT: Время затухания
(RT1: Время затухания 1)
(RT2: Время затухания 2)
RL: Уровень затухания
(RL1: Уровень затухания 1)
(RL2: Уровень затухания 2)

Octave Shift Октавный перенос. Изменяет высоту нот с шагом в октаву. –2 - 0 - +2

Initial Level Начальный уровень. Начальная высота звука при нажатии клавиши. –64 - 0 - +63

Attack Time Время атаки. Время, за которое достигается уровень атаки с начального уровня. –64 - 0 - +63

Release 
Time

Время затухания. Время, за которое достигается уровень затухания после отпуска-
ния клавиши.

–64 - 0 - +63

Release 
Level

Уровень затухания. Целевой уровень, достигаемый сразу после отпускания клави-
ши.

–64 - 0 - +63

Stretch Tune Растяжение настройки. Повышает на полтона высокие ноты и понижает на пол-
тона низкие ноты для достижения растянутой настройки. Выключите этот режим 
для исполнения с обычной (нерастянутой) настройкой.

Off, Piano1, Piano2, 
Piano3, Piano4, Piano5, 
E.Piano1, E.Piano2

Filter >Ent Фильтр. Это группа редактируемых параметров, связанных с фильтрами (тембры).
yy В этой группе вертикальная ось (Уровень) на схеме огибающей высоты звука 

соответствует применению фильтра.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Огибающая высоты звука».
yy Initial Level, Attack Time, Release Time, Release Level

Cutoff Частота среза. Задает частоту среза фильтра. –64 - 0 - +63
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Использование встроенных тембров 

Индикация 
на дисплее

Описание Установки

Resonance Резонанс. Задает степень отсечения звука вблизи частоты среза. –64 - 0 - +63

Velocity 
Sense

Динамическая чувствительность. Задает степень изменения в фильтре в соответ-
ствии с изменением силы нажатия на клавиши.

–64 - 0 - +63

Envelope 
Depth

Глубина огибающей. Определяет, как будет применяться огибающая.
0 - 127

Attack Level Уровень атаки. Целевой уровень достигается сразу после нажатия клавиши. –64 - 0 - +63

Decay Time Время спада. Время, за которое звук достигает уровня спада с уровня атаки. –64 - 0 - +63

Decay Level
Уровень спада. Уровень, на котором звук задерживается, пока нажата клавиша или 
педаль.

–64 - 0 - +63

Amp >Ent Усилитель. Это группа редактируемых параметров, связанных с усилителем (гром-
костью).
yy В этой группе вертикальная ось (Уровень) на схеме огибающей высоты звука 

соответствует громкости.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Огибающая высоты звука».
yy Initial Level, Attack Time, Release Time
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Фильтр» выше. 
Attack Level, Decay Time, Decay Level

Volume Громкость. Задает громкость усилителя. 0 - 127

Velocity 
Sense

Динамическая чувствительность. Задает степень изменения громкости в соответ-
ствии с изменением силы нажатия на клавиши.

–64 - 0 - +63

Effect >Ent Эффект. Это группа редактируемых параметров эффектов. Для получения подроб-
ной информации смотрите раздел «Применение эффектов к нотам» (стр. 18).

DSP Edit >Ent Редактирование DSP-эффектов. Это группа редактируемых параметров 
DSP-эффектов (стр. 18). Нажмите кнопку  (ENTER) для перехода к экрану ре-
дактирования DSP-эффектов (стр. 18).

Chorus Send Посыл хоруса. Определяет, как хорус (стр. 18) применяется к тембру. 0 - 127

Delay Send Посыл дилэя. Определяет, как дилэй (стр. 18) применяется к тембру. 0 - 127

Reverb Send Посыл реверберации. Определяет, как реверберация (стр. 18) применяется к тембру. 0 - 127

LFO >Ent Низкочастотная модуляция. Это группа редактируемых параметров низкочастот-
ной модуляции, применяемой к высоте, фильтру и усилителю.

Pitch Wave
FilterAmpWave

Тип волны. Задает один из следующих типов волны для использования для низко-
частотной модуляции.
Параметр FilterAmpWave используется совместно для фильтра и усилителя.

Смотрите ячейку слева.

Sin
(синусоидальная волна)

Tri
(треугольная волна)

Saw up
(пилообразная волна  
с зубцами вверх)

Saw down
(пилообразная волна  
с зубцами вниз)

Puls 1:3
(квадратная волна 1:3)

Puls 2:2
(квадратная волна 2:2)

Puls 3:1
(квадратная волна 3:1)

Pitch Rate
FilterAmpRate

Скорость. Скорость (частота) низкочастотной модуляции. Параметр 
FilterAmpWave используется совместно для фильтра и усилителя.

–64 - 0 - +63

Pitch Depth 
Filter Depth 
Amp Depth

Глубина. Определяет, как применяется низкочастотная модуляция. –64 - 0 - +63

Pitch Depth 
Filter Depth 
Amp Depth

Задержка. Задает степень временной задержки при применении низкочастотной 
модуляции.

–64 - 0 - +63
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Использование встроенных тембров 

Индикация 
на дисплее

Описание Установки

Pitch Rise
Filter Rise
Amp Rise

Время достижения максимального эффекта. Задает время с начала применения 
низкочастотной модуляции до достижения эффектом уровня, определенного 
параметром «Depth» выше.

–64 - 0 - +63

Pitch Depth 
Filter Depth 
Amp Depth

Глубина модуляции. Задает глубину низкочастотной модуляции.
–64 - 0 - +63

Pan >Ent Панорамирование. Это группа редактируемых параметров, связанных с панорами-
рованием (стереопозицией звука).

Dynamic 
Panning

Динамическое панорамирование. Для отражения изменений в панорамировании пар-
тий воспроизводимого звучания выберите для этого параметра установку «On» [Вкл.]. 
Выберите установку «Off» [Выкл.], если вы не хотите, чтобы изменения отражались.

Off, On

Pan Position
Позиция панорамирования. Выберите «PreDSP» для применения панорамирова-
ния перед DSP или «PostDSP» для применения панорамирования после DSP.

PreDSP, PostDSP

Name Edit Редактирование названия. Изменяет название выбранного в данный момент тембра.
yy Для получения подробной информации смотрите раздел «Как изменить назва-

ние тембра» на стр. 10.

�� Редактируемые параметры тембров ударных инструментов

Индикация 
на дисплее

Описание Установки

Inst Edit >Ent Редактирование инструментов. Это группа редактируемых инструментов, назна-
ченных на каждую клавишу.
yy Нажмите клавишу клавиатуры, чтобы выбрать клавишу для редактирования.
yy Для получения подробной информации о параметре «DSP Edit» смотрите раздел 

«Применение эффектов к нотам» (стр. 18).

C- - G9

Inst Select

Выбор номера инструмента. Задает номер тембра ударного инструмента, назна-
ченного на каждую клавишу.

См. «Перечень тембров 
ударных инструмен-
тов» в конце данного 
руководства.

Note Off 
Mode

Режим выключения ноты. В случае включения этого параметра при отпускании 
клавиши будет выполняться выключение ноты.

Off, On

Assign 
Group

Назначение группы. Задает значение от 1 до 15, соответствующее группе, в кото-
рую будет помещена выбранная в данный момент клавиша. В каждый момент вре-
мени может звучать только одна клавиша в группе (неполифоническое звучание).

Off, 1 - 15

Pitch >Ent

Огибающая высоты звука. Для получения подробной информации смотрите пункт 
«Огибающая высоты звука» для мелодических тембров на стр. 11.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Огибающая высоты звука» для мелодических тембров на стр. 11. 
Initial Level, Attack Time

Coarse Tune Грубая настройка. Изменяет высоту нот с шагом в полутон. –24 - 0 - +24

Fine Tune
Точная настройка. Осуществляет точную настройку высоты звука. Понижает настрой-
ку на величину до -256 или повышает настройку на величину до +255 с шагом в цент.

–256 - 0 - +255

Filter >Ent

Фильтр. Для получения подробной информации смотрите пункт «Фильтр» для 
мелодических тембров на стр. 11.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Фильтр» для мелодических тембров на стр. 11. 
Cutoff, Resonance, Envelope Depth, Attack Level, Decay Time, Decay Level

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Огибающая высоты звука» для мелодических тембров на стр. 11. 
Initial Level, Attack Time

Amp >Ent

Усилитель. Для получения подробной информации смотрите пункт «Усилитель» 
для мелодических тембров на стр. 12.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Усилитель» для мелодических тембров на стр. 12. 
Volume

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Огибающая высоты звука» для мелодических тембров на стр. 11. 
Initial Level, Attack Time

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Фильтр» для мелодических тембров на стр. 11. 
Attack Level, Decay Time, Decay Level
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Использование встроенных тембров 

Индикация 
на дисплее

Описание Установки

Pan Панорамирование. Задает стереопозицию звука ударного инструмента. –64 - 0 - +63

Effect >Ent

Эффект. Это группа редактируемых параметров DSP-эффектов (стр. 18). Нажмите 
кнопку  (ENTER) для перехода к экрану редактирования DSP-эффектов (стр. 18).
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Эффект» для мелодических тембров на стр. 12. 
Chorus Send, Delay Send, Reverb Send

yy Значения, полученные путем умножения значений посыла, заданных для эффек-
тов, связанных с определенными инструментами (Effect >Ent), и значений посы-
ла, заданных для глобальных эффектов (Common Effect >Ent), в сгруппированном 
виде посылаются в систему.

yy Когда включен параметр «DSP On/Off» (применяется DSP), установки хоруса, 
дилэя и реверберации могут быть заданы параметром «Common Effect >Ent», при-
веденным ниже.

DSP
On/Off

Включение/выключение DSP. Задает, применяются или не применяются к тем-
брам DSP-эффекты.

Off, On

Common Effect 
>Ent

Общий эффект. Это группа редактируемых параметров эффектов. Для получения 
подробной информации смотрите пункт «Эффект» для мелодических тембров на 
стр. 12.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Эффект» для мелодических тембров на стр. 12. 
Chorus Send, Delay Send, Reverb Send

Pan >Ent Панорамирование. Это группа редактируемых параметров, связанных с панорами-
рованием (стереопозицией звука).
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Панорамирование» для мелодических тембров на стр. 13 
Dynamic Panning, Pan Position

Name Edit Редактирование названия. Изменяет название выбранного в данный момент тембра
yy Для получения подробной информации смотрите раздел «Как изменить назва-

ние тембра» на стр. 10.

�� Редактируемые параметры тембров Hex Layer

Тембры Hex Layer имеют два вида редактируемых параметров: параметры, влияющие на определенный слой, и пара-
метры, влияющие на все слои.
yy Шесть ползунков (  - ) и четыре ручки ( ) могут использоваться для быстрой и простой регулировки некоторых 
настроек с использованием приведенных ниже пунктов настроек (стр. 8).

Редактируемые параметры, влияющие на определенный слой

1.	 Выберите «Layer Edit >Ent», а затем нажмите кнопку  (ENTER), чтобы войти в группу.

2.	 При помощи кнопок  (PART) «минус» (-) и «плюс» (+) выберите номер слоя, который вы хотите отредактировать.

           
yy При выборе в качестве номера слоя установки «ALL» (все слои), в левой части дисплея может отобразиться знак 
«x», указывающий редактируемую партию. Это означает, что не все слои имеют одну и ту же установку выбранного 
в данный момент параметра.
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Использование встроенных тембров 

Индикация 
на дисплее

Описание Установки

Layer On/Off Включение/выключение слоя. Выбор установки «Off» отключает слой. Off, On

Wave Number Номер волны. Выбирает тип формы волны.
yy См. «Перечень форм волны» в конце данного руководства для получения ин-

формации о типах волн.

См. «Перечень форм 
волны» в конце данно-
го руководства.

Pitch >Ent Огибающая высоты звука. Для получения подробной информации смотрите пункт 
«Огибающая высоты звука» для мелодических тембров на стр. 11.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Огибающая высоты звука» для мелодических тембров на стр. 
11. Для пунктов «Initial Level» и «Release Level» вы можете вводить значения в 
диапазоне от -256 до 0 до +255. Для пунктов «Attack Time» и «Release Time» вы 
можете вводить значения в диапазоне от 0 до 127.

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Огибающая высоты звука» для тембров ударных инструментов 
на стр. 13. 
Coarse Tune, Fine Tune

yy Для получения подробной информации о приведенных ниже пунктах настрой-
ки смотрите пункт «Фильтр» для мелодических тембров на стр. 11. Для пунктов 
«Attack Level» и «Decay Level» вы можете вводить значения в диапазоне от -256 
до 0 до +255. 
Attack Level, Decay Time, Decay Level

Key Follow
Увязка параметров клавиш. Регулирует величину изменения высоты между соседними 
клавишами клавиатуры. Более высокое значение соответствует большей величине 
изменения.

–128 - 0 - +127

Key Follow 
Base

Базовая клавиша для увязки. Клавиша клавиатуры, относительно которой осу-
ществляется увязка.

C- - G9

Split Shift
Прерывистый сдвиг. Звучит форма волны, назначенная на клавишу, расположен-
ную на заданном расстоянии выше или ниже нажатой клавиши. При этом исполь-
зуется высота звука, соответствующая нажатой клавише.

–12 - 0 - +12

LFO Layer 
Depth

Глубина низкочастотной модуляции слоя. Регулирует применение низкочастотной 
модуляции к каждому слою.

0 - 127

Filter >Ent Фильтр. Для получения подробной информации смотрите пункт «Фильтр» для 
мелодических тембров на стр. 11.
yy Для получения подробной информации о приведенных ниже пунктах настрой-

ки смотрите пункт «Фильтр» для мелодических тембров на стр. 11. Вы можете 
вводить значения в диапазоне от 0 до 127. 
Cutoff, Resonance, Attack Level, Envelope Depth

yy Для получения подробной информации о приведенных ниже пунктах настрой-
ки смотрите пункт «Огибающая высоты звука» для мелодических тембров на 
стр. 11. Вы можете вводить значения в диапазоне от 0 до 127. 
Initial Level, Attack Time

Filter Type

Тип фильтра. Задает диапазон, срезаемый фильтром.
LPF1: �фильтр 6 дБ/октава для низкочастотных составляющих. Без эффекта резонанса. 

Подходит для акустических инструментов.
LPF2: �фильтр 12 дБ/октава для низкочастотных составляющих. Без эффекта резонан-

са. Подходит для акустических инструментов.
LPF3: �фильтр 12 дБ/октава для низкочастотных составляющих. С эффектом резонан-

са. Подходит для синтезированных тембров.
BPF:   �фильтр 6 дБ/октава для частотной составляющий вблизи частоты среза. С эф-

фектом резонанса.
HPF:   �фильтр 12 дБ/октава для высокочастотных составляющих. С эффектом резо-

нанса.

См. ячейку слева.

Velocity 
Sense

Динамическая чувствительность. Задает степень изменения в фильтре в соответствии 
с силой нажатия на клавиши.

–64 - 0 - +63

Decay 1 Time Время спада 1. Время, за которое звук достигает уровня спада 1 с уровня атаки. 0 - 127

Decay 1 Level Уровень спада 1. Целевой уровень для изменения с уровня атаки до уровня спада 1. 0 - 127

Decay 2 Time Время спада 2. Время, за которое звук достигает уровня спада 2 с уровня спада 1. 0 - 127

Decay 2 Level
Уровень спада 2. Второй целевой уровень для изменения с уровня спада 1 до уровня 
спада 2.

0 - 127
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Индикация 
на дисплее

Описание Установки

Decay 3 Time Время спада 3. Время, за которое звук достигает уровня спада 3 с уровня спада 2. 0 - 127

Decay 3 Level
Уровень спада 3. Третий целевой уровень для изменения с уровня спада 2 до уров-
ня спада 3.

0 - 127

Release 1 Time
Время затухания 1. Время, за которое достигается уровень затухания 1 после от-
пускания клавиши.

0 - 127

Release 1 Level Уровень затухания 1. Целевой уровень, достигаемый сразу после отпускания клавиши. 0 - 127

Release 2 Time
Время затухания 2. Время, за которое достигается уровень затухания 2 с уровня 
затухания 1.

0 - 127

Release 2 Level Уровень затухания 2. Второй целевой уровень, достигаемый после отпускания клавиши. 0 - 127

Key Follow
Увязка параметров клавиш. Регулирует величину изменения фильтра между со-
седними клавишами клавиатуры. Более высокое значение соответствует большей 
величине изменения.

–128 - 0 - +127

Key Follow 
Base

Базовая клавиша для увязки. Клавиша клавиатуры, относительно которой осу-
ществляется увязка.

C- - G9

LFO Layer 
Depth

Глубина низкочастотной модуляции слоя. Регулирует применение низкочастотной 
модуляции к каждому слою.

0 - 127

Amp >Ent Усилитель. Для получения подробной информации смотрите пункт «Усилитель» 
для мелодических тембров на стр. 12.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Усилитель» для мелодических тембров на стр. 12. 
Volume, Velocity Sense

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Усилитель» для тембров ударных инструментов на стр. 13. 
Pan

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Огибающая высоты звука» для мелодических тембров на стр. 11. 
Вы можете вводить значения в диапазоне от 0 до 127. 
Initial Level, Attack Time

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Фильтр» для мелодических тембров на стр. 11. Вы можете вво-
дить значения в диапазоне от 0 до 127. 
Attack Level

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Фильтр» для тембров Hex Layer на стр. 15. 
Decay 1 Time, Decay 1 Level, Decay 2 Time, Decay 2 Level, Decay 3 Time, Decay 3 
Level, Release 1 Time, Release 1 Level, Release 2 Time

Key Follow
Увязка параметров клавиш. Регулирует величину изменения громкости между со-
седними клавишами клавиатуры. Более высокое значение соответствует большей 
величине изменения.

–128 - 0 - +127

Key Follow 
Base

Базовая клавиша для увязки. Клавиша клавиатуры, относительно которой осу-
ществляется увязка.

C- - G9

LFO Layer 
Depth

Глубина низкочастотной модуляции слоя. Регулирует применение низкочастотной 
модуляции к каждому слою.

0 - 127

Effect >Ent Для получения подробной информации смотрите пункт «Эффект» для мелодиче-
ских тембров на стр. 12.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Эффект» для тембров ударных инструментов на стр. 14. 
DSP On/Off

yy Для получения подробной информации о приведенных ниже пунктах настройки 
смотрите пункт «Эффект» для мелодических тембров на стр. 12. 
Chorus Send, Delay Send, Reverb Send

yy Значения, полученные путем умножения значений посыла, заданных для эф-
фектов, связанных с определенными инструментами (Effect >Ent), и значений 
посыла, заданных для глобальных эффектов (Common Effect >Ent), в сгруппиро-
ванном виде посылаются в систему.

yy Когда включен параметр «DSP On/Off» (применяется DSP), установки хоруса, 
дилэя и реверберации могут быть заданы параметром «Common Effect >Ent», 
приведенным ниже.

Key Range Low Нижняя граница диапазона клавиатуры. Задает нижнюю границу действующего диа-
пазона клавиатуры. При нажатии клавиш ниже этого диапазона звук не производится.
yy После нажатия кнопки  (NUM KEY) для входа в режим ввода цифр вы можете 

использовать клавиши клавиатуры для ввода значений.

C- - G9



17

Использование встроенных тембров 

Индикация 
на дисплее

Описание Установки

Key Range High Верхняя граница диапазона клавиатуры. Задает верхнюю границу действующего 
диапазона клавиатуры. При нажатии клавиш выше этого диапазона звук не произ-
водится.
yy После нажатия кнопки  (NUM KEY) для входа в режим ввода цифр вы можете 

использовать клавиши клавиатуры для ввода значений.

C- - G9

VelocityRangeLow Нижняя граница диапазона динамической чувствительности. Задает минимальное 
значение эффективной динамической чувствительности. Если скорость нажатия 
на клавиши меньше этой установки, звук не производится.

0 - 127

VelocityRangeHigh Верхняя граница диапазона динамической чувствительности. Задает максималь-
ное значение эффективной динамической чувствительности. Если скорость на-
жатия на клавиши больше этой установки, звук не производится.

0 - 127

Start Trigger Триггер запуска. Задает, звучит ли нота при нажатии (KeyOn) или отпускании 
(KeyOff) клавиши клавиатуры.

KeyOn, KeyOff

Редактируемые параметры, влияющие на все слои
Редактируемые параметры
yy Затененные ячейки указывают группу, состоящую из нескольких параметров. Нажатие кнопки  (ENTER) отобра-
жает параметры данной группы.

Индикация 
на дисплее

Описание Установки

Init By Wave Инициализация параметров путем выбора волны. Выберите «On», чтобы связать 
огибающую и другие параметры при изменениях волны, или «Off», чтобы не вы-
полнять связь.

Off, On

Volume Громкость. Общая громкость тембров Hex Layer. 0 - 127

Common Effect 
>Ent

Общий эффект. Это группа редактируемых параметров эффектов. Для получения 
подробной информации смотрите пункт «Эффект» для мелодических тембров на 
стр. 12.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Эффект» для мелодических тембров на стр. 12. 
Chorus Send, Delay Send, Reverb Send

LFO >Ent Низкочастотная модуляция. Это группа редактируемых параметров низкочастотной 
модуляции, применяемой к высоте звуков наложенного тембра. Для получения 
подробной информации смотрите пункт «Низкочастотная модуляция» для мелоди-
ческих тембров на стр. 12.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Низкочастотная модуляция» для мелодических тембров на стр. 
12. Вы можете вводить значения в диапазоне от 0 до 127. 
Pitch Rate, Pitch Delay, Pitch Rise, Pitch Mod.Depth*, Filter Amp Rate, Filter Delay, 
Filter Rise, Filter Mod.Depth*, Amp Delay, Amp Rise, Amp Mod.Depth* 
* Выполняет ту же операцию, что и диапазон настройки мелодического тембра 
(–64 - 0 - +63).

yy Для получения подробной информации о приведенных ниже пунктах настрой-
ки смотрите пункт «Низкочастотная модуляция» для мелодических тембров на 
стр. 12. Однако учтите, что диапазоны настройки параметров Pitch Depth, Filter 
Depth и Amp Depth составляют –128 - 0 - +127. 
Pitch Wave, Filter Amp Wave, Pitch Depth, Filter Depth, Amp Depth

Detune Расстройка. Делает настройку слоев с 1 по 6 слегка различной. Большее значение 
параметра увеличивает степень расстройки. Максимальное значение (31) задает раз-
личие в 100 центов (полутон) между слоем 1 и слоем 6.

0 - 31
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Индикация 
на дисплее

Описание Установки

Pitch Lock 1-2
Pitch Lock 3-4
Pitch Lock 5-6

Блокировка высоты. Когда эта настройка включена для слоя 2, высота звучания 
слоя 2 меняется на высоту слоя 1, то есть для обоих слоев высота звучания стано-
вится одинаковой. То же верно для слоев 3 и 4 и слоев 5 и 6.

Off, On

Stretch Tune Для получения подробной информации смотрите пункт «Растяжение настройки» 
для мелодических тембров на стр. 11.

KeyOffVel.Mode Режим динамической чувствительности. Выберите «KeyOff», чтобы использо-
вать скорость отпускания клавиши, или «KeyOn», чтобы использовать скорость 
нажатия на клавишу. Выберите «Both», чтобы отражать оба вида динамической 
чувствительности (скорость нажатия и скорость отпускания).

KeyOff, KeyOn, Both

Pan >Ent Панорамирование. Это группа редактируемых параметров, связанных с пано-
рамированием (стереопозицией звука). Для получения подробной информации 
смотрите пункт «Панорамирование» для мелодических тембров на стр. 13.
yy Для получения подробной информации о приведенных ниже пунктах настройки 

смотрите пункт «Панорамирование» для мелодических тембров на стр. 13. 
Dynamic Panning, Pan Position

Name Edit Редактирование названия. Изменяет название выбранного в данный момент 
тембра
yy Для получения подробной информации смотрите раздел «Как изменить назва-

ние тембра» на стр. 10.

Применение эффектов к нотам

Ваше цифровое пианино имеет три типа эффектов, каж-
дый из которых включает описанные ниже эффекты.

A) Цифровой процессор сигналов (DSP)
Набор универсальных DSP-эффектов помогает улуч-
шить звучание тембров. Например, к тембру электро-
гитары может быть применен эффект дисторшн, чтобы 
сделать звучание более мощным. Имеется 20 различных 
видов DSP-эффектов; наиболее подходящий для вы-
бранного тембра эффект применяется автоматически.

Б) Системные эффекты (SYSTEM)
Эти эффекты используются для всех партий цифрового 
пианино. Глубина эффекта может быть отрегулирована 
путем задания уровня посыла сигнала партии на каждый 
системный эффект.
yy Хорус (System Chorus): объединяет несколько слоев 
одной и той же ноты для создания более глубокого 
звука.

yy Дилэй (System Delay): задерживает входной сигнал и 
подает его обратно для создания эффекта повторения 
и придания звучанию широты.

yy Реверберация (System Reverb): добавляет к звучанию 
реверберацию, чтобы создать эффект исполнения в 
большом помещении или концертном зале.

yy Резонанс (System Resonance): имитирует резонанс 
струн акустического фортепиано. 
Струнный резонанс (String Reso): генерирует резонанс 
струн для наживаемых клавиш. 
Демпферный резонанс (Damper Reso): генерирует 
струнный резонанс при нажатии педали демпфера. 
Учтите, что использование струнного резонанса и 
демпферного резонанса поддерживается только для 
некоторых тембров.* 
* Тембры, для которых может быть настроен параметр 
микшера «Reso.Return Level» (стр. 32).

В) Мастер-эффекты (MASTER)
Эти эффекты обрабатывают общий выходной сигнал 
цифрового пианино.
yy Эквалайзер (Master Equalizer (EQ)): регулирует основ-
ные частотные характеристики. Мастер-эквалайзер 
может использоваться для регулировки частоты и 
усиления четырех частотных диапазонов: low, mid1, 
mid2 и high.

yy Компрессор (Master Compressor): сжимает общий 
выходной сигнал инструмента. Этот эффект может 
использоваться для подавления рассеивания уровня 
и ограничения уровня входного сигнала, чтобы он не 
превышал установленного значения.
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Как применить эффект к тембру

1.	 Выберите тембр, к которому вы хотите применить 
эффект.

2.	 Нажмите кнопку  (EFFECT, SONG) необходимое 
число раз, чтобы загорелась индикаторная лампа рядом 
с надписью «EFFECT».

3.	 Нажмите одну из указанных ниже кнопок в зависимости 
от типа эффекта, который вы хотите применить.

А) DSP: кнопка  (DSP)
Б) SYSTEM: кнопка  (SYSTEM)
В) MASTER:  (MASTER)

Ниже представлен экран настройки эффектов. На 
скриншоте показана индикация дисплея при на-
стройке системных эффектов.

yy Индикаторная лампа кнопки не загорится при 
нажатии кнопки  (DSP),  (SYSTEM) или  
(MASTER).

yy Для того чтобы узнать, включен эффект или вы-
ключен, проверьте тип и установку эффекта.

yy К экрану настройки эффектов также можно 
перейти из экрана редактирования сценических 
настроек (стр. 31).

4.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( ) 
выберите пункт настройки.
yy Для получения подробной информации о ре-
дактируемых параметрах смотрите подразделы 
«Редактируемые параметры DSP-эффектов», 
«Редактируемые параметры системных эффек-
тов» и «Редактируемые параметры мастер-эф-
фектов», начиная со стр. 19.

yy Если на дисплее отображается индикация 
«>ENT», это означает, что для данной операции 
редактирования имеются другие параметры, 
помимо отображаемых. В этом случае нажатием 
кнопки  (ENTER) вы можете перейти к следую-
щей странице параметров.

5.	 Измените настройки параметров по желанию.

6.	 После завершения редактирования нажмите кнопку  
(EXIT).
yy Нажмите кнопку  (EXIT) требуемое число раз, 
чтобы вернуться к экрану, отображаемому до на-
чала редактирования.

Временный обход DSP

Используйте приведенную ниже процедуру для вре-
менного обхода DSP и переключения с выбранного в 
данный момент тембра зоны на тембр без DSP-эффекта.
yy Вы можете обойти DSP для каждого тембра каждой зоны.

1.	 Удерживайте кнопку  (DSP) нажатой до тех пор, пока 
ее индикаторная лампа не начет мигать.

2.	 Для отмены обхода еще раз нажмите кнопку  (DSP) 
и удерживайте ее нажатой, пока ее индикаторная лампа 
не погаснет.
yy Учтите, что режим обхода будет отменен, даже 
если вы переключитесь на другой набор сцениче-
ских настроек.

�� Редактируемые параметры DSP-эффектов

yy Выберите «Through», если вы хотите отключить при-
менение DSP-эффектов.

yy Вы можете выбрать разные DSP-эффекты для партий 
с 1 по 4.

yy Партии с 5 по 16 не поддерживают использование 
DSP-эффектов.

- -: Through [Сквозной]
Выберите эту установку, если вы не хотите применять DSP-эффект. При выборе этой 
установке настраиваемые параметры отсутствуют.

01: Equalizer [Эквалайзер]
Это трехполосный эквалайзер.
Параметры и диапазоны настроек:
1: �EQ1 Frequency [Частота эквалайзера 1] (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Гц]) 

Регулирует центральную частоту эквалайзера 1.
2: �EQ1 Gain [Усиление эквалайзера 1] (от -12 до 0 до +12) 

Регулирует усиление эквалайзера 1.
3: �EQ2 Frequency [Частота эквалайзера 2] (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Гц]) 

Регулирует центральную частоту эквалайзера 2.
4: �EQ2 Gain [Усиление эквалайзера 2] (от -12 до 0 до +12) 

Ргулирует усиление эквалайзера 2.
5: �EQ3 Frequency [Частота эквалайзера 3] (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Гц]) 

Регулирует центральную частоту эквалайзера 3.
6: �EQ3 Gain [Усиление эквалайзера 3] (от -12 до 0 до +12) 

Регулирует усиление эквалайзера 3.
7: �Input Level [Входной уровень] (от 0 до 127) 

Регулирует входной уровень.
8: �Wet Level [Уровень обработанного сигнала] (от 0 до 127) 

Регулирует уровень звука с эффектом.
9: �Dry Level [Уровень необработанного сигнала] (от 0 до 127) 

Регулирует уровень исходного звука.

Примечание: величина усиления выражается не в дБ.
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02:	� Compressor [Компрессор]
Сжимает входной сигнал, благодаря чему могут подавляться колебания уровня и могут 
дольше звучать приглушенные звуки.
Параметры и диапазоны настроек:
1:	� Attack [Атака] (от 0 до 127)
	� Регулирует величину нарастания входного сигнала. При низком значении ком-

прессор работает быстро, подавляя нарастание входного сигнала. При высоком 
значении работа компрессора замедляется, благодаря чему нарастание входного 
сигнала происходит без изменений.

2:	� Release [Затухание] (от 0 до 127)
	� Регулирует время с момента падения входного сигнала ниже определенного уровня 

до момента остановки работы компрессора.
	� Если вы хотите получить ощущение атаки (без компрессии в начале звука), уста-

новите для данного параметра наименьшее возможное значение. Для того чтобы 
компрессия применялась всегда, установите высокое значение.

3:	� Depth [Глубина] (от 0 до 127)
	� Регулирует сжатие аудиосигнала.
4:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
	� Громкость выходного сигнала изменяется в соответствии с установкой глубины и 

характеристиками входного сигнала.
5:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

03: Limiter [Ограничитель]
Ограничивает уровень входного сигнала, так чтобы он не поднимался выше заданного 
значения.
Параметры и диапазоны настроек:
1:	� Limit [Предел] (от 0 до 127)
	� Регулирует уровень громкости, используемый в качестве предельного значения.
2:	� Attack [Атака] (от 0 до 127)
	� Регулирует величину нарастания входного сигнала.
3:	� Затухание (от 0 до 127)
	� Регулирует время с момента падения входного сигнала ниже определенного уровня 

до момента остановки работы ограничителя.
4:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом. Громкость выходного сигнала изменяется 

в соответствии с установкой предела и характеристиками входного сигнала. Ис-
пользуйте данный параметр для корректировки таких изменений.

5:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

04: Enhancer [Усилитель]
Усиливает очертания нижнего и верхнего диапазонов входного сигнала.
Параметры и диапазоны настроек:
1:	� Low Frequency [Низкие частоты] (от 0 до 127)
	� Регулирует частоту усилителя низких частот.
2:	� Low Gain [Усиление низких частот] (от 0 до 127)
	� Регулирует усиление низких частот.
3:	� High Frequency [Высокие частоты] (от 0 до 127)
	� Регулирует частоту усилителя высоких частот.
4:	� High Gain [Усиление высоких частот] (от 0 до 127)
	� Регулировка усиления высоких частот.
5:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
6:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
7:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

05: Early Reflection [Раннее отражение]
Извлекает звук первоначального отражения из звука с реверберацией.
Применяет к нотам эффект акустического присутствия.
Параметры и диапазоны настроек:
1:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
2:	� Feedback [Обратная связь] (от 0 до 127)
	� Регулирует повтор отраженного звука.
3:	� Tone [Оттенок] (от 0 до 127)
	� Регулирует оттенок отраженного звука.
4:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
5:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

06: Phaser [Фейзер]
Производит отчетливо пульсирующее, широкое звучание, применяя низкочастотную 
модуляцию для изменения фазы входного сигнала, а затем смешивая полученный 
сигнал с исходным входным сигналом.
Параметры и диапазоны настроек:
1:	� Resonance [Резонанс] (от 0 до 127)
	� Регулирует силу обратной связи.
2:	� Manual [Ручная настройка] (от -64 до 0 до +63)
	� Регулирует контрольную величину сдвига фейзера.
3:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
4:	� Depth [Глубина] (диапазон: от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
5:	� LFO Waveform [Форма волны генератора низкой частоты] (Sin [Синусоидальная],  

Tri [Треугольная], Random [Случайная])
	� Выбирает форму волны генератора низкой частоты.
6:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
7:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
8:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

07: Chorus [Хорус]
Придает звучанию глубину и широту.
Параметры и диапазоны настроек:
1:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
2:	� Depth [Глубина] (от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
3:	� LFO Waveform [Форма волны генератора низкой частоты] (Sin [Синусоидальная],  

Tri [Треугольная])
	� Выбирает форму волны генератора низкой частоты.
4:	� Feedback [Обратная связь] (от –64 до 0 до +63)
	� Регулирует силу обратной связи.
5:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
6:	� Polarity [Полярность] (-, +)
	� Меняет полярность низкочастотного модулирующего сигнала одного канала.
7:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
8:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

�08: Flanger [Флэнжер]
Применяет к звучанию сильно пульсирующую и металлическую реверберацию. Вы-
бирает форму волны генератора низкой частоты.
Параметры и диапазоны настроек:
1:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
2:	� Depth [Глубина] (от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
3:	� LFO Waveform [Форма волны генератора низкой частоты] (Sin [Синусоидальная],  

Tri [Треугольная], Random [Случайная])
	� Выбирает форму волны генератора низкой частоты.
4:	� Feedback [Обратная связь] (от –64 до 0 до +63)
	� Регулирует силу обратной связи.
5:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
6:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
7:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

�09: Tremolo [Тремоло]
Регулирует громкость входного сигнала с использованием низкочастотной модуляции.
Параметры и диапазоны настроек:
1:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
2:	� Depth [Глубина] (от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
3:	� LFO Waveform [Форма волны генератора низкой частоты] (Sin [Синусоидальная],  

Tri [Треугольная], Tra [Трапецеидальная])
	� Выбирает форму волны генератора низкой частоты.
4:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
5:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.
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10: Auto Pan [Автопанорамирование]
Непрерывно выполняет панорамирование входного сигнала влево-вправо с использо-
ванием низкочастотной модуляции.
Параметры и диапазоны настроек:
1:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
2:	� Depth [Глубина] (от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
3:	� LFO Waveform [Форма волны генератора низкой частоты] (Sin [Синусоидальная], Tri 

[Треугольная], Tra [Трапецеидальная])
	� Выбирает форму волны генератора низкой частоты.
4:	� Manual [Ручная настройка] (от -64 до 0 до +63)
	� Регулирует панорамирование (стереопозицию). -64 соответствует крайней левой 

позиции, а +63 – крайней правой.
5:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
6:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

11: Rotary [Вращающийся динамик]
Это имитатор вращающегося динамика.
Параметры и диапазоны настроек:
1:	� Speed [Скорость] (Slow [Медленный], Fast [Быстрый])
	� Переключает режим скорости между быстрым и медленным.
2:	� Brake [Остановка] (Rotate [Вращение], Stop [Остановка])
	� Останавливает вращение динамика.
3:	� Fall Accel [Ускорение падения] (от 0 до 127)
	� Регулирует ускорение при переключении режима скорости с быстрого на медленный.
4:	� Rise Accel [Ускорение подъема] (от 0 до 127)
	� Регулирует ускорение при переключении режима скорости с медленного на быстрый.
5:	� Slow Rate [Скорость в медленном режиме] (от 0 до 127)
	� Регулирует скорость вращения динамика в медленном режиме.
6:	� Fast Rate [Скорость в быстром режиме] (от 0 до 127)
	� Регулирует скорость вращения динамика в быстром режиме.
7:	� Vibrato/Chorus [Вибрато/Хорус] (Off [Выкл.], V1, C1, V2, C2, V3, C3)
	� Выбирает тип вибрато (V) и хоруса (C).
8:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
9:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

12: �Drive Rotary [Вращающийся динамик с овер-
драйвом]

Это имитатор вращающегося динамика с возможностью овердрайва.
Параметры и диапазоны настроек:
1:	� Overdrive Gain [Усиление овердрайва] (от 0 до 127)
	� Регулирует усиление овердрайва.
2:	� Overdrive Level [Уровень овердрайва] (от 0 до 127)
	� Регулирует выходной уровень овердрайва.
3:	� Speed [Скорость] (Slow [Медленный], Fast [Быстрый])
	� Переключает режим скорости между быстрым и медленным.
4:	� Brake [Остановка] (Rotate [Вращение], Stop [Остановка])
	� Останавливает вращение динамика.
5:	� Fall Accel [Ускорение падения] (от 0 до 127)
	� Регулирует ускорение при переключении режима скорости с быстрого на медленный.
6:	� Rise Accel [Ускорение подъема] (от 0 до 127)
	� Регулирует ускорение при переключении режима скорости с медленного на 

быстрый.
7:	� Slow Rate [Скорость в медленном режиме] (от 0 до 127)
	� Регулирует скорость вращения динамика в медленном режиме.
8:	� Fast Rate [Скорость в быстром режиме] (от 0 до 127)
	� Регулирует скорость вращения динамика в быстром режиме.
9:	� Vibrato/Chorus [Вибрато/Хорус] (Off [Выкл.], V1, C1, V2, C2, V3, C3)
	� Выбирает тип вибрато (V) и хоруса (C).
10:	�Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
11:	�Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

13: LFO Wah [Вау с низкочастотной модуляцией]
Это эффект вау, автоматически регулирующий частоту с использованием низкочастот-
ной модуляции.
Параметры и диапазоны настроек:
1:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень. Входной сигнал может искажаться при высоком уровне 

громкости звука, при большом количестве аккордов или большом значении резонан-
са. Отрегулируйте значение этого параметра для устранения такого искажения.

2:	� Resonance [Резонанс] (от 0 до 127)
	� Регулирует силу обратной связи.
3:	� Manual [Ручная настройка] (от 0 до 127)
	� Регулирует контрольную частоту фильтра вау.
4:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
5:	� Depth [Глубина] (диапазон: от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
6:	� LFO Waveform [Форма волны генератора низкой частоты] (Sin [Синусоидальная],  

Tri [Треугольная], Random [Случайная])
	� Выбирает форму волны генератора низкой частоты.
7:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
8:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

14: Auto Wah [Авто-вау]
Это эффект вау, автоматически регулирующий частоту в соответствии с уровнем 
входного сигнала.
Параметры и диапазоны настроек:
1:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень. Входной сигнал может искажаться при высоком уровне 

громкости звука, при большом количестве аккордов или большом значении резонан-
са. Отрегулируйте значение этого параметра для устранения такого искажения.

2:	� Resonance [Резонанс] (от 0 до 127)
	� Регулирует силу обратной связи.
3:	� Manual [Ручная настройка] (от 0 до 127)
	� Регулирует контрольную частоту фильтра вау.
4:	� Depth [Глубина] (от –64 до 0 до +63)
	� Регулирует глубину эффекта вау в соответствии с уровнем входного сигнала.
	� При установке положительного значения фильтр вау открывается прямо про-

порционально уровню входного сигнала, производя яркое звучание. При установке 
отрицательного значения фильтр вау закрывается прямо пропорционально уровню 
входного сигнала, производя глухое звучание.

5:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
6:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

15: Distortion [Дисторшн]
Дисторшн + вау + имитатор усиления
Параметры и диапазоны настроек:
1:	� Dist Gain [Усиление дисторшн] (от 0 до 127)
	� Регулирует усиление входного сигнала дисторшн.
2:	� Dist Level [Уровень дисторшн] (от 0 до 127)
	� Регулирует выходной уровень дисторшн.
3:	� Dist Low [Дисторшн низких частот] (от 0 до 127)
	� Регулирует усиление дисторшн в низкочастотном диапазоне.
4:	� Dist High [Дисторшн высоких частот] (от 0 до 127)
	� Регулирует усиление дисторшн в высокочастотном диапазоне.
5:	� Wah Depth [Глубина вау] (от –64 до 0 до +63)
	� Регулирует глубину вау в соответствии с уровнем входного сигнала.
6:	� Wah Manual [Ручная настройка вау] (от 0 до 127)
	� Регулирует контрольную частоту фильтра вау.
7:	� Routing [Маршрутизация] (Dist, Wah, Wah-Dist, Dist-Wah)
	� Задает порядок подключения эффектов дисторшн и вау.
8:	� Amp [Усилитель] (Bypass, TCombo, FCombo, ACombo, BCombo, JCombo, MStack, 

RStack, BassC, BassS)
	� Задает тип имитации усиления.
9:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
10:	�Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.
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16:	� Pitch Shifter [Изменение высоты тона]
Этот эффект изменяет высоту входного сигнала.
Параметры и диапазоны настроек:
1:	� Pitch [Высота] (от -24 до 0 до +24)
	� Регулирует величину сдвига высоты звучания с шагом в четверть тона.
2:	� High Damp [Демпфирование высоких частот] (от 0 до 127)
	� Регулирует демпфирование высоких частот. Чем меньше значение, тем сильнее 

демпфирование.
3:	� Feedback [Обратная связь] (от 0 до 127)
	� Регулирует силу обратной связи.
4:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
5:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
6:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

17:	� Multi Chorus [Мульти-хорус]
Это хорус-эффект с шестью различными фазами низкочастотной модуляции.
Параметры и диапазоны настроек:
1:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
2:	� Depth [Глубина] (от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
3:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
4:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

18:	� Ring Modulator [Кольцевой модулятор]
Перемножает входной сигнал с сигналом встроенного генератора колебаний для 
создания металлического звучания.
Параметры и диапазоны настроек:
1:	� OSC Frequency [Частота генератора колебаний] (от 0 до 127)
	� Устанавливает опорную частоту встроенного генератора колебаний.
2:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
3:	� Depth [Глубина] (от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
4:	� Tone [Тембр] (от 0 до 127)
	� Регулирует тембр входного звучания кольцевого модулятора.
5:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
6:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.

19:	� Delay [Дилэй]
Задерживает входной сигнал и подает его обратно для создания эффекта повторения.
Параметры и диапазоны настроек:
1:	� Delay Time [Время задержки] (от 0 до 127)
	� Регулирует общее время задержки.
2:	� Delay Ratio L [Отношение задержки Л] (от 0 до 127)
	� Регулирует отношение времени задержки левого канала к общему времени задержки.
3:	� Delay Ratio R [Отношение задержки П] (от 0 до 127)
	� Регулирует отношение времени задержки правого канала к общему времени за-

держки.
4:	� Delay Level L [Уровень задержки Л] (от 0 до 127)
	� Регулирует уровень левого канала.
5:	� Delay Level R [Уровень задержки П] (от 0 до 127)
	� Регулирует уровень правого канала.
6:	� Feedback Type [Тип обратной связи] (Stereo, Cross)
	� Выбирает тип обратной связи.
	� Stereo: стереофоническая обратная связь
	� Cross: перекрёстная обратная связь
7:	� Feedback [Обратная связь] (от 0 до 127)
	� Регулирует силу обратной связи.
8:	� High Damp [Демпфирование высоких частот] (от 0 до 127)
	� Регулирует демпфирование высоких частот. Чем меньше значение, тем сильнее 

демпфирование.
9:	� Delay Tempo Sync [Синхронизация темпа с задержкой] (Off [Выкл.], 1/4, 1/3, 3/8, 

1/2, 2/3, 3/4, 1)
	� Задает, как фактическое общее время задержки синхронизируется с темпом
	� • Off: использует значение времени задержки.
	� • От 1/4 до 1: использует значение, соответствующее количеству долей.
10:	�Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
11:	�Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.
12:	�Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.

20:	� Piano Effect [Эффект фортепиано]
Этот эффект предназначен для имитации игры на акустическом фортепиано.
Параметры и диапазоны настроек:
1:	� Lid Type [Тип крышки] (Closed [Закрытая], Semi Opened [Полуоткрытая], Full Opened 

[Полностью открытая])
	� Регулирует то, как резонирует звук, в соответствии с положением крышки фортепиано.
2:	� Reflection Level [Уровень отражения] (от 0 до 127)
	� Регулирует уровень первоначального отражения.
3:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
4:	� Wet Level [Уровень обработанного сигнала] (от 0 до 127)
	� Регулирует уровень звука с эффектом.
5:	� Dry Level [Уровень необработанного сигнала] (от 0 до 127)
	� Регулирует уровень исходного звука.
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�� Редактируемые параметры системных эффектов

yy Партии с 5 по 16 не поддерживают использование 
эффектов резонанса.

System Chorus [Системный хорус]
Параметры и диапазоны настроек:
1:	� Type [Тип] (Light Cho [Легкий хорус], Chorus [Хорус], FB Chorus [Хорус с обратной 

связью], Flanger [Флэнжер])
	� Выбирает тип хоруса.
2:	� LFO Rate [Степень низкочастотной модуляции] (от 0 до 127)
	� Регулирует степень низкочастотной модуляции.
3:	� LFO Depth [Глубина низкочастотной модуляции] (от 0 до 127)
	� Регулирует глубину низкочастотной модуляции.
4:	� Feedback [Обратная связь] (от 0 до 127)
	� Регулирует силу обратной связи.
5:	� Tone [Оттенок] (от 0 до 127)
	� Регулирует оттенок звука.
6:	� Delay Time [Время задержки] (от 0 до 127)
	� Регулирует время задержки.
7:	� Delay Send [Посыл дилэя] (от 0 до 127)
	� Регулирует уровень посыла сигнала на системный дилэй.
8:	� Reverb Send [Посыл реверберации] (от 0 до 127)
	� Регулирует уровень посыла сигнала на системную реверберацию.
9:	� Return [Возврат] (от 0 до 127)
	� Регулирует уровень возврата.

System Delay [Системный дилэй]
Параметры и диапазоны настроек:
1:	� Time [Время задержки] (от 0 до 127)
	� Регулирует общее время задержки.
2:	� Feedback [Обратная связь] (от 0 до 127)
	� Регулирует силу обратной связи центрального канала.
3:	� High Damp [Демпфирование высоких частот] (от 0 до 127)
	� Регулирует демпфирование высоких частот. Чем меньше значение, тем сильнее 

демпфирование.
4:	� Ratio L [Отношение Л] (от 0 до 127)
	� Регулирует отношение времени задержки левого канала к общему времени задержки.
5:	� Ratio C [Отношение Ц] (от 0 до 127)
	� Регулирует отношение времени задержки центрального канала к общему времени 

задержки.
6:	� Ratio R [Отношение П] (от 0 до 127)
	� Регулирует отношение времени задержки правого канала к общему времени за-

держки.
7:	� Level L [Уровень Л] (от 0 до 127)
	� Регулирует уровень левого канала.
8:	� Level C [Уровень Ц] (от 0 до 127)
	� Регулирует уровень центрального канала.
9:	� Level R [Уровень П] (от 0 до 127)
	� Регулирует уровень правого канала.
10:	�Tempo Sync [Синхронизация темпа] (Off [Выкл.], 1/4, 1/3, 3/8, 1/2, 2/3, 3/4, 1, 4/3, 

3/2, 2)
	� Задает, как фактическое общее время задержки синхронизируется с темпом
	� • Off: использует значение времени задержки.
	� • От 1/4 до 2: использует значение, соответствующее количеству долей.
11:	�Reverb Send [Посыл реверберации] (от 0 до 127)
	� Регулирует уровень посыла сигнала на системную реверберацию.
12:	�Return [Возврат] (от 0 до 127)
	� Регулирует уровень возврата.

�System Reverb [Системная реверберация]
Параметры и диапазоны настроек:
1:	� Type [Тип] (Room [Комната], Hall1 [Зал 1], Hall2 [Зал 2], Plate [Пластина])
	� Выбирает тип хоруса.
2:	� Time [Время] (от 0 до 127)
	� Регулирует время реверберации.
3:	� Early Reflection [Раннее отражение] (от 0 до 127)
	� Регулирует уровень первоначального отражения.
4:	� High Damp [Демпфирование высоких частот] (от 0 до 127)
	� Регулирует демпфирование высоких частот. Чем меньше значение, тем сильнее 

демпфирование.
5:	� Tone [Оттенок] (от 0 до 127)
	� Регулирует оттенок звука.
6:	� Return [Возврат] (от 0 до 127)
	� Регулирует уровень возврата.

System Resonance [Системный резонанс]
Параметры и диапазоны настроек:
1:	� String Reso Send [Посыл струнного резонанса] (от 0 до 15)
	� Регулирует уровень посыла сигнала на струнный резонанс.
2:	� Damper Reso Send [Посыл демпферного резонанса] (от 0 до 15)
	� Регулирует уровень посыла сигнала на демпферный резонанс.
3:	� Damper Noise Enable [Посыл демпферного резонанса] (от 0 до 15)
	� Включает/выключает эффект шума демпфера.

�� Редактируемые параметры мастер-эффектов

Master Compressor [Мастер-компрессор]
Параметры и диапазоны настроек:
1:	� Threshold [Порог] (от 0 до 127)
	� Регулирует пороговый уровень (где начинается применение эффекта).
	� Устанавливайте более низкое значение для эффекта компрессора, а более высокое 

значение – для эффекта ограничителя.
2:	� Ratio [Коэффициент] (от 0 до 127)
	� Регулирует коэффициент сжатия.
	� Устанавливайте более низкое значение для эффекта компрессора, а более высокое 

значение – для эффекта ограничителя.
3:	� Level [Уровень] (от 0 до 127)
	� Регулирует выходной уровень.
4:	� Attack [Атака] (от 0 до 127)
	� Регулирует время до начала эффекта компрессии.
	� Более низкое значение обеспечивает быстрое начало действия компрессора; при этом 

подавляется атака входного сигнала. Более высокое значение задерживает работу 
компрессора; при этом атака входного сигнала подается на выход в исходном виде.

5:	� Release [Затухание] (от 0 до 127)
	� Регулирует время затухания.
	� Регулирует время до завершения эффекта компрессии.
6:	� Position [Позиция] (PreEQ [Перед эквалайзером], PostEQ [После эквалайзера])
	� Выбирает позицию соединения компрессора и эквалайзера

Master Equalizer [Мастер-эквалайзер]
Параметры и диапазоны настроек:
1:	� Low Gain [Усиление низких частот] (от -12 до 0 до +12)
	� Регулирует усиление низких частот.
2:	� Low Frequency [Низкие частоты] (200, 400, 800 [Гц])
	� Выбирает частоту среза в диапазоне низких частот.
3:	� Mid 1 Gain [Усиление средних частот 1] (от -12 до 0 до +12)
	� Регулирует усиление нижне-средних частот.
4:	� Mid 1 Frequency [Средние частоты 1] (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Гц])
	� Выбирает частоту среза в диапазоне нижне-средних частот.
5:	� Mid 2 Gain [Усиление средних частот 2] (от -12 до 0 до +12)
	� Регулирует усиление высоко-средних частот.
6:	� Mid 2 Frequency [Средние частоты 2] (1.0k, 1.3k, 1.6k, 2.0k, 2.5k, 3.2k, 4.0k, 5.0k [Гц])
	� Выбирает частоту среза в диапазоне высоко-средних частот.
7:	� High Gain [Усиление высоких частот] (от -12 до 0 до +12)
	� Регулирует усиление высоких частот.
8:	� High Frequency [Высокие частоты] (200, 400, 800 [Гц])
	� Выбирает частоту среза в диапазоне высоких частот.
9:	� Input Level [Входной уровень] (от 0 до 127)
	� Регулирует входной уровень.
10:	�Output Level [Выходной уровень] (от 0 до 127)
	� Регулирует выходной уровень.
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Вы можете редактировать встроенные арпеджио цифро-
вого пианино для создания ваших собственных ориги-
нальных арпеджио. Вы также можете записывать ваши 
собственные музыкальные фразы для воспроизведения 
вместо существующих арпеджио. После редактирования 
арпеджио вы можете присвоить ему название и сохра-
нить его в качестве пользовательского арпеджио.
yy Термин «клавишное воспроизведение» означает за-
пуск воспроизведения фразы нажатием клавиши кла-
виатуры. При клавишном воспроизведении нажатие 
клавиши клавиатуры, заданной в качестве начальной 
ноты («ORG NOTE»), запустит воспроизведение 
фразы в первоначально записанном виде. Нажатие 
клавиши, отличной от заданной в качестве начальной 
ноты («ORG NOTE»), сдвинет высоту нот фразы в со-
ответствии с нажатой клавишей.

Как воспроизвести записанную 
фразу в форме арпеджио

1.	 Удерживайте нажатой кнопку  (ARPEGGIO) до тех 
пор, пока на дисплее не отобразится показанный ниже 
экран выбора вида арпеджио.
При этом загорится индикаторная лампа кнопки.

Номер арпеджио Название арпеджио

2.	 Нажмите кнопку  ( ).
На дисплее отобразится экран выбора целевого 
объекта (TARGET:ARPEGGIO).

3.	 Нажмите кнопку  «плюс» (+).
Дисплей переключится на экран выбора целевой 
фразы (TARGET:PHRASE) и отобразит номер и 
название выбранной в данный момент фразы.

yy Учтите, что редактирование арпеджио невозмож-
но, когда фраза выбрана в качестве цели.

4.	 Нажмите кнопку  ( ).
На дисплее отобразится режим выбора фразы, и 
значок  переместится влево от названия фразы.

5.	 Выберите желаемый номер фразы.

6.	 Дважды нажмите кнопку  ( ).
Скобки  переместятся на начальную ноту 
(«ORG NOTE»).

7.	 При помощи кнопок  «минус» (-) и «плюс» (+) задай-
те название клавиши начальной ноты.
yy Вы можете задать название клавиши в диапазоне 
от C- до G9.

yy Если вы хотите, чтобы фраза всегда воспроиз-
водилась в соответствии с установкой «ORIG 
NOTE» вне зависимости от нажатой для запуска 
воспроизведения клавиши, выберите установку 
«Fix», следующую за G9.

8.	 Нажмите клавиши, чтобы начать воспроизведение 
фразы.
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Как выбрать разные виды 
арпеджио для каждой зоны

1.	 Удерживайте нажатой кнопку  (ARPEGGIO) до тех 
пор, пока на дисплее не отобразится экран выбора вида 
арпеджио.
При этом загорится индикаторная лампа кнопки.

2.	 При помощи кнопок   (ZONE, -/+) отобразите номер 
зоны, которую вы хотите выбрать.

3.	 Убедившись, что значок   расположен рядом с номе-
ром арпеджио, отобразите номер арпеджио, который 
вы хотите выбрать для зоны.
yy Повторите шаги 2 и 3 необходимое число раз, 
чтобы выбрать арпеджио для каждой зоны.

Как включить или выключить режим 
арпеджио для определенной зоны

1.	 Удерживайте нажатой кнопку  (ARPEGGIO) до тех 
пор, пока на дисплее не отобразится экран выбора вида 
арпеджио.
При этом загорится индикаторная лампа кнопки.

2.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( ) 
выберите «ZONE».

3.	 При помощи кнопок  «минус» (-) и «плюс» (+) вклю-
чите или выключите арпеджио зоны.

ПРИМЕЧАНИЕ

yy Учтите, что, если звучание зоны отключено, арпеджио 
также не будет воспроизводиться. Чтобы отменить 
отключение звучания зоны, нажмите кнопку  (EXIT) 
для выхода из экрана выбора вида арпеджио, а затем 
одновременно нажмите две кнопки   (ZONE, -/+).

Редактирование арпеджио

Имеется два вида арпеджио: пошаговое и вариационное.
yy Для пошагового арпеджио можно редактировать его 
шаги и параметры. Пошаговое арпеджио может со-
держать до 16 шагов. Вы можете изменить следующие 
настройки каждого шага.

TYPE [Тип]:	� Задает ноту арпеджио, исполняе-
мую в каждом шаге по отношению 
к самой низкой ноте (L1) или 
самой высокой ноте (U1) арпед-
жио. Также имеется тип (P2-P5), 
который может использоваться 
для озвучивания до пяти нот одно-
временно.

NOTE [Нота]:	� Если вы хотите сдвинуть ноту с 
нажатой клавиши клавиатуры, 
используйте эту настройку для за-
дания величины сдвига с шагом в 
полутон.

VELO [Скорость]:	� Задает уровень громкости.
CTRL [Управление]:	� Это управляющие данные MIDI.

yy Для вариационного арпеджио можно редактировать 
только его параметры.

1.	 Выберите вид арпеджио, которое вы хотите отредакти-
ровать.

2.	 Нажмите кнопку  (EDIT).

3.	 При помощи кнопок  ( ) и  ( ) выберите «Step 
Edit», а затем нажмите кнопку  (ENTER).
yy Параметр «Step Edit» не отобразится, если в шаге 
1 выше вы выбрали вариационное арпеджио.



26

Автоматическое исполнение арпеджио 

4.	 Измените значения параметров TYPE, NOTE, VELO и CTRL по желанию.

yy Когда выбран пункт [TYPE], используйте кнопки  «минус» (-) и «плюс» (+) для переключения установок 
TYPE: выкл. (Off), вкл. (TYPE) и лига* (TIE). Однако учтите, что установка TIE для шага «STEP 01» отсутству-
ет. 
* Выбор установки TIE продлевает длительность предыдущего шага на один шаг. Она может использоваться 
для продления звучания нот.

yy Параметры NOTE и VELO не могут быть настроены для шага, параметр TYPE которого установлен на значе-
ние Off или TIE.

yy В приведенной ниже таблице показаны настройки в меню редактирования шага арпеджио.

Уровень меню
Описание Установки

1 2

Step Edit >Ent

TYPE

Задает ноту арпеджио, которая будет исполняться в выбранном в данный 
момент шаге по отношению к самой низкой ноте (L1) нажатых клавиш 
клавиатуры.
yy Если заданное для шага значение превышает число нажатых клавиш 

клавиатуры, соответствующие ноты арпеджио будут исполняться на одну 
октаву выше. Например, если задана установка L4, нажатие только трех 
клавиш приведет к исполнению L1 на одну октаву выше.

yy После одной октавы соответствующая нота вернется к исходной октаве.

L1 - L8

Задает ноту арпеджио, которая будет исполняться в выбранном в данный 
момент шаге по отношению к самой высокой ноте (U1) нажатых клавиш 
клавиатуры.
yy Если заданное для шага значение превышает число нажатых клавиш 

клавиатуры, соответствующие ноты арпеджио будут исполняться на одну 
октаву ниже. Например, если задана установка U4, нажатие только трех 
клавиш приведет к исполнению U1 на одну октаву ниже.

yy После одной октавы соответствующая нота вернется к исходной октаве.

U1 - U8

Задает ноту, которая будет исполняться в выбранном в данный момент шаге по 
отношению к самой высокой ноте нажатых клавиш клавиатуры.
yy Если число нажатых клавиш меньше заданного здесь значения, арпеджио 

будет исполняться только до нажатых клавиш.

P2 - P5

NOTE
Задает сдвиг исполняемой ноты по отношению к нотам нажимаемых клавиш 
клавиатуры с шагом в полутон.

–24 - 0 - +24

VELO
Изменяет динамическую характеристику (уровень громкости) нажатых клавиш 
клавиатуры.

–64 - 0 - +63

CTRL

Этот параметр может использоваться для изменения значения типа управле-
ния, выбранного с использованием меню редактирования параметров арпед-
жио в шаге 7 данной процедуры.

Bend: –128 - 0 - +127,
Pan (Control Change 10):
–64 - 0 - +63
Control Change 00 - 97
(кроме Pan):
0 - 127

5.	 После настройки параметров TYPE, NOTE, VELO и CTRL нажмите кнопку  (EXIT), чтобы вернуться в меню «ARPEGGIO».
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6.	 При помощи кнопок  ( ) и  ( ) переместите курсор выбора ( ) на пункт «Parameter», а затем нажмите кнопку   
(ENTER).

7.	 Измените параметры по желанию.
yy В следующей таблице приведено содержимое меню редактирования параметров арпеджио.

Уровень меню
Описание Установки

1 2

Parameter >Ent

Max Step
Максимальный шаг. Этот параметр может быть изменен 
только для пошагового вида.

1 - 16

Step Size Размер шага. Задает длительность нот между шагами.

Note Length

Длительность ноты. Длительность воспроизведения ноты 
задается в виде процентной величины от размера шага. 
Значение 100% задает длительность, равную исходной ноте, а 
значение 50% задает длительность, равную половине длитель-
ности исходной ноты.

1 - 100%

Groove
Ритм. Задает время начала звучания синкопированного шага. 
Значение 50% задает одинаковое время, тогда как большее значе-
ние увеличивает длительность первой половинной ноты.

10 - 90%

Groove Type

Тип ритма. Задает длительность нот, когда для параметра 
«Groove» выбрано значение, отличное от 50%.

Normal: воспроизведение осущест-
вляется с длительностью шага, 
основанной на фактической про-
центной величине.
Short: если длительность шага 
изменена, приводит длительность 
шага в соответствие с меньшей 
длительностью.

Velocity

Динамическая характеристика. Задает значение динамической 
характеристики вводимого арпеджио. Установка «KeyOn» задает 
значение динамической характеристики в соответствии с давле-
нием, оказанным на клавишу.

KeyOn, 1 - 127

Hold Pedal
Задержка педалью. Включает/выключает задержку с исполь-
зованием педали. Этот параметр может быть изменен только 
для пошагового вида.

Off, On

Control 
Track

. Включает (On) или выключает (Off) использование управля-
ющих данных. При выборе установки «Only» включена только 
управляющая дорожка. Этот параметр может быть изменен 
только для пошагового вида.

Off, On, Only

Control Type
Тип управления. Задает тип управляющих данных. Этот параметр 
может быть изменен только для пошагового вида.

Bend, C. (Control Change) 00 - 97

Smooth
Сглаживание. При выборе установки «On» добавляются 
управляющие данные. Этот параметр может быть изменен 
только для пошагового вида.

Off, On

yy Для получения информации о параметрах, которые должны быть отредактированы для воспроиз-
ведения арпеджио в наборе сценических настроек, смотрите главу «Использование сценических 
настроек (Учебное руководство)» (стр. 31).
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Удаление пошаговых данных 
арпеджио

Используйте приведенную ниже процедуру для удале-
ния предустановленных пошаговых данных или поша-
говых данных, отредактированных с использованием 
параметра «Step Edit» (стр. 25), и создания новых поша-
говых данных с нуля.

1.	 Когда на дисплее отображается экран выбора вида 
арпеджио, нажмите кнопку  (EDIT).

2.	 При помощи кнопок  ( ) и  ( ) выберите пункт 
«Clear Step», а затем нажмите кнопку  (ENTER).

На дисплее появится сообщение «Clear?» [Уда-
лить?].

3.	 Еще раз нажмите кнопку  (ENTER).
На дисплее появится запрос подтверждения 
(«SURE?» [Уверены?]).

4.	 Нажмите кнопку  (YES).
После удаления данных на дисплее появится со-
общение «Complete!» [Завершено!].

Переименование арпеджио

После редактирования арпеджио вы можете присвоить 
ему название и сохранить его в качестве пользователь-
ского арпеджио.

1.	 Выполните шаги 1 и 2 процедуры, приведенной в раз-
деле «Редактирование арпеджио» (стр. 25).

2.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( ) 
выберите пункт «NameEdit», а затем нажмите кнопку  
(ENTER).

3.	 Измените название.

4.	 После завершения редактирования нажмите кнопку  
(EXIT).
yy Нажмите кнопку  (EXIT) требуемое число раз, 
чтобы вернуться к экрану, отображаемому до на-
чала редактирования.
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Запись с использованием 
секвенсора фраз

yy Общая емкость памяти для записи с использованием 
секвенсора фраз составляет около 1 Мб. Максимально 
допустимый размер одной фразы равен около 8 Кб.

yy Помимо исполняемых на клавиатуре нот, записы-
ваемые фразы также включают операции педалей, 
колес, ручек и ползунков. Однако запись операций 
возможна, когда на педали, колесу модуляции, ручки 
и ползунки назначены следующие сообщения, переда-
ваемые по MIDI-каналу.

– CC00 - CC97
– NRPN
– RPN
– Pressure

Настройки микшера при 
воспроизведении композиции

Помимо операций по редактированию дорожек, опи-
санных в РУКОВОДСТВЕ ПОЛЬЗОВАТЕЛЯ (Основ-
ные сведения), экран композиции (песенного секвен-
сора) также может использоваться для редактирования 
настроек и выполнения операций, приведенных ниже.
– Настройки микшера при воспроизведении композиции
– Изменение темпа при воспроизведении композиции
– Удаление данных дорожки
– Инициализация композиции

1.	 Выберите желаемую композицию.
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2.	 Отредактируйте композицию по желанию.
yy Для настройки параметров микшера выберите «Song Mixer».

yy Параметры микшера описаны в следующей таблице.

Индикация 
на дисплее

Описание Установки

Bank Select MSB Выбор банка, старший байт. Задает номер старшего байта выбора банка.
yy Для задания тембра на экране песенного микшера выберите номера «Bank Select 

MSB» и «Program Change»; для этого обратитесь к «Перечню тембров» в конце 
данного руководства.

0 - 127

Program Change Смена программы. Задает номер программы смены тембров. Для получения под-
робной информации см. пункт «Bank Select MSB» выше.

0 - 127

Channel Задает номер выходного канала. 1 - 16

Volume Громкость. 0 - 127

Pan Панорамирование. Регулирует позицию звука (слева/справа) в стереополе. –64 - 0 - +63

Coarse Tune Грубая настройка. Изменяет высоту нот с шагом в полутон. –24 - 0 - +24

Fine Tune Точная настройка. Изменяет высоту нот с шагом в цент. –99 - 0 - +99

Bend Range Диапазон изменения высоты тона. Задает (с шагом в полутон) максимальное из-
менение высоты тона при вращении колеса  (BENDER).

0 - 24

Chorus Send Посыл хоруса. Определяет, как применяется эффект хорус. 0 - 127

Delay Send Посыл дилэя. Определяет, как применяется эффект дилэй. 0 - 127

Reverb Send Посыл реверберации. Определяет, как применяется эффект реверберации. 0 - 127

Generator Out Включение/выключение посыла на внутренний процессор. Задает, будет ли ин-
формация о каждой партии посылаться на внутренний источник звука цифрового 
пианино.

Off, On

USB Out Включение/выключение выхода USB. Задает, будет ли с разъема  (USB) осу-
ществляться передача MIDI-информации о каждой партии.

Off, On

MIDI Out Включение/выключение выхода MIDI. Задает, будет ли с разъема  (MIDI OUT/
THRU) осуществляться передача MIDI-информации о каждой партии.

Off, On

Как изменить темп при 
воспроизведении композиции

1.	 Выполните шаги 1 и 2 процедуры, приведенной в 
разделе «Настройки микшера при воспроизведении 
композиции» (стр. 29), для выбора «Tempo».

2.	 Отрегулируйте установку темпа.

Как очистить дорожку или 
инициализировать композицию

1.	 Выполните шаги 1 и 2 процедуры, приведенной в раз-
деле «Настройки микшера при воспроизведении компо-
зиции» (стр. 29), для выбора желаемого параметра.

yy Для очистки дорожки выберите «Track Clear». 
Далее, на появившемся экране выберите при 
помощи кнопок   «минус» (-) и «плюс» (+) до-
рожку, которую вы хотите очистить.

yy Для инициализации композиции выберите «Song 
Initialize».

2.	 Нажмите кнопку  (ENTER).
yy На дисплее появится запрос подтверждения 
(«SURE?» [Уверены?]).

yy Если вы хотите отменить операцию, нажмите 
кнопку  (NO) или  (EXIT).

3.	 Нажмите кнопку  (YES).
yy После завершения операции на дисплее появит-
ся сообщение «Complete!» [Завершено!].
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Как отредактировать набор сценических настроек

1.	 Выберите банк и номер желаемого набора сценических настроек.

2.	 Отредактируйте сценические настройки по желанию.
yy Ниже описан каждый из редактируемых параметров.

Редактируемые параметры

Индикация 
на дисплее

Описание Установки

Zone Edit >Ent Редактирование параметров зон. Эта группа включает параметры зон с 1 по 4.
yy Используйте кнопки   (ZONE) «минус» (-) и «плюс» (+) для выбора зоны, 

которую вы хотите отредактировать.

Mixer Edit >Ent Редактирование микшера. Эта группа включает параметры микшера внутри зон.

Zone Enable
Включение/выключение зон. Включает или выключает все зоны. Установка этого параметра 
отличается от установки включения/выключения партии микшера (Part Enable) (стр. 37).

Off, On

Tone

Тембр. Выбирает тембр для каждой зоны. Установка этого параметра совпадает с 
установкой тембра партии микшера (стр. 37). Используйте кнопки с  по  для 
переключения между категориями тембров.
yy Когда выбран этот параметр, вы можете выбрать тембр при помощи той же опе-

рации, которая используется в режиме выбора тембра.
yy Категория DRM (ударные инструменты) не может быть выбрана для зоны 2. 

DRM и HEX (Hex Layer) не могут быть выбраны для зоны 3 или зоны 4. При на-
жатии кнопки категории, которая не может быть выбрана, на дисплее отобража-
ется сообщение «Invalid Tone» [Неправильный тембр]. В этом случае дождитесь 
исчезновения сообщения или нажмите кнопку другой категории, чтобы убрать 
сообщение.

PNO (Фортепиано):
P00 - U39
EPN (Электропиано):
P000 - U109
ORG (Орган): P00 - U49
STR (Струнные, мед-
ные духовые): P00 - U89
GTR (Гитара, бас):
P00 - U59
VAR (Синтезатор,
разные): P000 - U129
DRM (Ударные):
P00 - U39
HEX (Hex Layer):
P000 - U199

Key Range 
Low

Нижняя граница диапазона клавиатуры. Задает нижнюю границу диапазона кла-
виатуры для каждой зоны. Эта установка используется в сочетании с установкой 
«Key Rage High» для настройки диапазонов клавиатуры для каждой зоны.
Например, задание диапазона от F3 (нижняя граница) до C7 (верхняя граница) 
для зон 1 и 2 и диапазона от C2 (нижняя граница) до E3 (верхняя граница) для зон 
3 и 4 позволит использовать тембры зон 1 и 2 на правом диапазоне клавиатуры, а 
тембры зон 3 и 4 – на левом диапазоне, как показано на рисунке ниже.

yy После нажатия кнопки  (NUM KEY) для входа в режим ввода номера вы може-
те использовать клавиши клавиатуры для ввода значений.

C- - G9



32

Использование сценических настроек 

Индикация 
на дисплее

Описание Установки

Key Range 
High

Верхняя граница диапазона клавиатуры. Задает верхнюю границу диапазона клавиату-
ры для каждой зоны. Эта установка используется в сочетании с установкой «Key Rage 
Low» для настройки диапазонов клавиатуры для каждой зоны.

C- - G9

Velo.Range 
Low

yy После нажатия кнопки  (NUM KEY)  для входа в режим ввода номера вы мо-
жете использовать клавиши клавиатуры для ввода значений.

0 - 127

Velo.Range 
High

Нижняя граница диапазона динамической чувствительности. Это минимальное 
значение динамической чувствительности каждой зоны. Эта установка используется 
в сочетании с описанной ниже установкой «Velo.Range High» для задания диапазонов 
динамической чувствительности для каждой зоны.

0 - 127

Volume

Верхняя граница диапазона динамической чувствительности. Это максимальное 
значение динамической чувствительности каждой зоны. Эта установка используется 
в сочетании с описанной выше установкой «Velo.Range Low» для задания диапазонов 
динамической чувствительности для каждой зоны.

0 - 127

Pan Громкость. Установка этого параметра совпадает с установкой громкости партии микшера (стр. 37). –64 - 0 - +63

Coarse Tune
Панорамирование. Регулирует позицию звука (слева/справа) в стереополе. Установка 
этого параметра совпадает с установкой панорамирования партии микшера (стр. 37).

–24 - 0 - +24

Fine Tune Грубая настройка. Изменяет высоту нот с шагом в полутон. –99 - 0 - +99

Bend Range 
Down

Точная настройка. Установка этого параметра совпадает с установкой точной на-
стройки партии микшера (стр. 37).

0 - 24

Bend Range 
Up

Диапазон изменения высоты тона вниз. Величина изменения высоты звучания при 
повороте колеса изменения высоты тона вниз.

0 - 24

Chorus Send
Диапазон изменения высоты тона вверх. Величина изменения высоты звучания при 
повороте колеса изменения высоты тона вверх.

0 - 127

Delay Send
Посыл хоруса. Установка этого параметра совпадает с установкой посыла хоруса 
микшера (стр. 37).

0 - 127

Reverb Send Посыл дилэя. Установка этого параметра совпадает с установкой посыла дилэя микшера (стр. 37). 0 - 127

Resonance 
Send

Посыл реверберации. Установка этого параметра совпадает с установкой посыла 
реверберации микшера (стр. 37).

Off, On

Reso.Return 
Level

Посыл резонанса. Включает/выключает посыл на эффект резонанса сигнала каждой 
зоны.

0 - 127

Controller Edit 
>Ent

Уровень возврата резонанса. Установка этого параметра совпадает с установкой 
возврата резонанса микшера (стр. 37).

Knob1 
Enable

Включение/выключение ручки 1. Включает/выключает функционирование ручки  
(K1) для каждой зоны.

Off, On

Knob2 
Enable

Включение/выключение ручки 2. Включает/выключает функционирование ручки  
(K2) для каждой зоны.

Off, On

Knob3 
Enable

Включение/выключение ручки 3. Включает/выключает функционирование ручки  
(K3) для каждой зоны.

Off, On

Knob4 
Enable

Включение/выключение ручки 4. Включает/выключает функционирование ручки  
(K4) для каждой зоны.

Off, On

Slider1 
Enable

Включение/выключение ползунка 1. Включает/выключает функционирование пол-
зунка  (S1) для каждой зоны.

Off, On

Slider2 
Enable

Включение/выключение ползунка 2. Включает/выключает функционирование пол-
зунка  (S2) для каждой зоны.

Off, On

Slider3 
Enable

Включение/выключение ползунка 3. Включает/выключает функционирование пол-
зунка  (S3) для каждой зоны.

Off, On

Slider4 
Enable

Включение/выключение ползунка 4. Включает/выключает функционирование пол-
зунка  (S4) для каждой зоны.

Off, On

Slider5 
Enable

Включение/выключение ползунка 5. Включает/выключает функционирование пол-
зунка  (S5) для каждой зоны.

Off, On

Slider6 
Enable

Включение/выключение ползунка 6. Включает/выключает функционирование пол-
зунка  (S6) для каждой зоны.

Off, On

Bender 
Enable

Включение/выключение колеса изменения высоты тона. Включает/выключает функ-
ционирование колеса  (BENDER) для каждой зоны.

Off, On

Wheel 
Enable

Включение/выключение колеса модуляции. Включает/выключает функционирова-
ние колеса  (MODULATION) для каждой зоны.

Off, On

Pedal1 
Enable

Включение/выключение педали 1. Включает/выключает функционирование педа-
ли, подключенной к разъему  (DAMPER/PEDAL 1) для каждой зоны.

Off, On
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Описание Установки

Pedal2 Enable
Включение/выключение педали 2. Включает/выключает функционирование педали, 
подключенной к разъему  (PEDAL 2) для каждой зоны.

Off, On

Arpeggio 
Enable

Включение/выключение арпеджио. Включает/выключает функцию арпеджио (стр. 
24) для каждой зоны.

Off, On

Arpeggio Select 
> Ent

Выбор арпеджио. Это группа редактируемых параметров функции арпеджио.

Target
Целевой объект. Выбирает воспроизведение арпеджио (Arp) или секвенсора фраз 
(Phr) функцией арпеджио. Для получения подробной информации см. раздел «Как 
воспроизвести записанную фразу в форме арпеджио» (стр. 24).

Arp, Phr

Arpeggio 
Number

Номер арпеджио. Используйте этот параметр для выбора номера арпеджио (стр. 24).
P000 - U199

Arp.Phrase 
Numb

Номер фразы арпеджио. Выберите номер фразы для воспроизведения, когда в 
качестве целевого объекта (Target) арпеджио выбрана «фраза» (Phr). Для получения 
подробной информации см. раздел «Как воспроизвести записанную фразу в форме 
арпеджио» (стр. 24).

U000 - U999

Original Key

Исходная тональность. Задает воспроизведение в исходной тональности, использо-
ванной для записи, при выполнении клавишного воспроизведения. Для получения 
подробной информации см. раздел «Как воспроизвести записанную фразу в форме 
арпеджио» (стр. 24).

C- - G9, Fix

MIDI Edit >Ent Параметры MIDI. Это группа редактируемых параметров MIDI (стр. 39). При 
помощи кнопок  (ZONE) «минус» (-) и «плюс» (+) выберите одну из 16 партий 
звукового источника цифрового пианино для редактирования.

Octave Shift Октавный перенос. Изменяет высоту нот с шагом в октаву. –2 - 0 - +2

Transpose
Транспонирование. Изменяет высоту нот с шагом в полутон. Установка этого параме-
тра совпадает с установкой грубой настройки партии микшера (стр. 37).

–12 - 0 - +12

External 
Out Ch

Канал передачи на внешнее устройство. Задает MIDI-канал (стр. 39) для передачи 
MIDI-информации о каждой партии на внешнее устройство.

1 - 16

Generator 
Out

Включение/выключение посыла на внутренний процессор. Задает, будет ли информация о каж-
дой партии посылаться на внутренний источник звука цифрового пианино.

Off, On

MIDI Out Включение/выключение выхода MIDI. Задает, будет ли с разъема  (MIDI OUT/THRU) осу-
ществляться передача MIDI-информации о каждой партии.

Off, On

USB Out Включение/выключение выхода USB. Задает, будет ли с разъема  (USB) осущест-
вляться передача MIDI-информации о каждой партии.

Off, On

Prog & 
Bank Out

Включение/выключение передачи сообщений о смене программы и старшего 
байта банка. Включает/выключает режим передачи на внешнее устройство MIDI-
информации о смене программы (Prg) или старшего байта банка (Bnk) каждой партии.

Off, Prg, Bnk

PrgBank 
Edit >Ent

Это группа редактируемых параметров смены программы и старшего байта банка. Ре-
дактирование может выполняться даже, когда для параметра «ProgBank Out» выбрана 
установка «Off».

Bank MSB Старший байт банка. Вводит значение старшего байта банка смены программы. 0 - 127

Bank LSB Младший байт банка. Вводит значение младшего байта банка смены программы. 0 - 127

Prog.
Change

Смена программы. Вводит значение смены программы.
1 - 128

System Effect Edit 
>Ent

Параметры системных эффектов. Это группа редактируемых параметров систем-
ных эффектов (стр. 18).
Для получения подробной информации о групповых параметрах см. подраздел 
«Редактируемые параметры системных эффектов» (стр. 23).

Chorus Edit 
>Ent

Редактирование хоруса. Это группа редактируемых параметров хоруса в группе си-
стемных эффектов.

Delay Edit 
>Ent

Редактирование дилэя. Это группа редактируемых параметров дилэя в группе систем-
ных эффектов.

Reverb Edit 
>Ent

Редактирование реверберации. Это группа редактируемых параметров реверберации в 
группе системных эффектов.

String Reso Send Посыл струнного резонанса. Регулирует уровень посыла сигнала на струнный резонанс. 0 - 15

Damper Reso 
Send

Посыл демпферного резонанса. Регулирует уровень посыла сигнала на демпферный 
резонанс.

0 - 15

Damper Noise 
Enable

Включение шума демпфера. Включает/выключает эффект шума демпфера.
Off, On
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Master Effect Edit 
>Ent

Параметры мастер-эффектов. Это группа редактируемых параметров мастер-эф-
фектов (стр. 23). Для получения подробной информации о групповых параметрах 
см. подраздел «Редактируемые параметры мастер-эффектов» (стр. 23).

Compressor 
Edit >Ent

Редактирование компрессора. Это группа редактируемых параметров компрессора 
в группе мастер-эффектов.

Equalizer 
Edit >Ent

Редактирование эквалайзера. Это группа редактируемых параметров эквалайзера в 
группе мастер-эффектов.

Common Edit >Ent Это группа редактируемых параметров педали, PRN и NPRN.

Tempo
Темп. Регулирует скорость воспроизведения фразы. Вы также можете изменить темп воспроизве-
дения фразы при помощи кнопки  (TEMPO).

20 - 255

Phrase Номер фразы. Выбирает фразу секвенсора фраз (стр. 29). U000 - U999

Arpeggio
Выбор предустановленного вида арпеджио. См. раздел «Как использовать функцию 
арпеджио» в отдельном РУКОВОДСТВЕ ПОЛЬЗОВАТЕЛЯ (Основные сведения).

Off, On, Hold

Hammer 
Response

Отклик молоточков. Регулирует отклик молоточков в диапазоне от 0 (быстрый) до 7 
(медленный).

0 - 7

Knob1 Edit 
>Ent

Редактирование ручки 1. Это группа редактируемых параметров ручки  (K1). Редактирование 
может выполняться даже, когда для параметра «Knob1 Enable» выбрана установка «Off».

Target

Целевой объект. Выбирает параметры для управления контроллером. Например, 
установка «CC67:Soft» задает эффект софт-педали.
yy Для одного контроллера может быть задано два целевых объекта. Используйте кнопки 

 (ZONE) «минус» (-) и «плюс» (+) для переключения между целевыми объектами 1 и 2.
No Assign: Целевой объект не задан.
CC00 - CC97: изменение параметров управления MIDI*1
NRPN, RPN: параметры NRPN и RPN MIDI*1*2
Ch.Pressure: давление в MIDI-канале*1
Tempo: установка темпа (стр. 30)
EQ Low Gain - EQ High Gain: Мастер-эквалайзер >Усиление низких частот - Усиле-
ние высоких частот (стр. 23)
DSP Bypass: временно обходит DSP выбранной в данных момент зоны.
Ext.Volume: управляет значением громкости внешнего источника.
Layer Detune: расстройка слоя (стр. 17)
Layer1 Volume - Layer6: настройки параметров тембров каждого слоя
yy Могут быть назначены следующие параметры: Volume (громкость), Pan (панора-

мирование), OctShift (октавный перенос), DspOnOff (DSP вкл./выкл.), LfoPitch 
(высота тона для генератора низкой частоты), LfoFiltr (фильтр генератора низкой 
частоты), LfoAmp (усилитель генератора низкой частоты). Для получения подроб-
ной информации о каждом параметре смотрите редактируемые параметры в главе 
«Использование встроенных тембров (Учебное руководство)» на стр. 10.

Dsp Param 1-16: параметры DSP
Pedal1 On Rate, Pedal1 Off Rate, Pedal2 On Rate, Pedal2 Off Rate: скорость изменения зна-
чения при нажатии и скорость изменения значения при отпускании каждой педали*3
Arp Hold On/Off: установка задержки арпеджио*4
Song Str/Stp: запуск/остановка воспроизведения песенного секвенсора*4
Phrase Str/Stop: запуск/остановка воспроизведения фразы*4
Audio Str/Stop: запуск/остановка воспроизведения аудиофайла*4
*1 �Для получения подробной информации о каждом параметре см. Карту внедрения 

MIDI (http://world.casio.com/) и/или документацию по использованию MIDI.
*2 �После выбора этих параметров еще раз нажмите кнопку §42 (ENTER), а затем от-

регулируйте следующие пункты: 
MSB: 63H для NRPN, 65H для RPN (диапазон настройки: от 000 до 127) 
LSB: 62H для NRPN, 64H для RPN (диапазон настройки: от 000 до 127) 
Send Data: Задает, будет ли осуществляться при помощи ручки управление значени-
ем MSB или LSB. (Установки: MSB, LSB)

*3 �Этот параметр не поддерживается для разъема «DAMPER/PEDAL 1» (Педаль 1) 
или «PEDAL 2».

*4 �Этот параметр поддерживается только для разъемов «DAMPER/PEDAL 1» (Педаль 
1) и «PEDAL 2»

См. ячейку слева.

Min Value Минимальное значение. Минимальное выходное значение контроллера. 0 - 127

Max Value Максимальное значение. Максимальное выходное значение контроллера. 0 - 127

Knob2-4 
Edit >Ent

Редактирование ручек со 2 по 4. Это группа редактируемых параметров ручек  
c (K2) по (K4). Редактирование может выполняться даже, когда для параметра 
«Knob2-4 Enable» выбрана установка «Off». Редактируемые параметры аналогичны 
описанным выше параметрам для «Knob1 Edit >Ent».
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Slider1-6 Edit 
>Ent

Редактирование ползунков с 1 по 6. Это группа редактируемых параметров ползунков 
с  (S1) по  (S6). Редактирование может выполняться даже, когда для параметра 
«Slider1-6 Enable» выбрана установка «Off». Редактируемые параметры аналогичны 
описанным выше параметрам для «Knob1 Edit >Ent».

Modulation 
Edit >Ent

Редактирование колеса модуляции. Это группа редактируемых параметров колеса 
 (MODULATION). Редактирование может выполняться даже, когда для параметра 

«Wheel Enable» выбрана установка «Off». Редактируемые параметры аналогичны опи-
санным выше параметрам для «Knob1 Edit >Ent».

Pedal1 Edit 
>Ent

Демпферная педаль/педаль 1. Это группа редактируемых параметров педали, подклю-
ченной к разъему  (DAMPER/PEDAL 1). Редактирование может выполняться даже, 
когда для параметра «Pedal1 Enable» выбрана установка «Off».

Pedal 
Target Edit 
>Ent

Задает функцию педали, подключенной к разъему  (DAMPER/PEDAL 1). Редакти-
руемые параметры аналогичны описанным выше параметрам для «Target».

On Rate Скорость изменения значения при нажатии. 0 - 127

Off Rate Скорость изменения значения при отпускании. 0 - 127

Pedal2 Edit 
>Ent

Педаль 2. Это группа редактируемых параметров педали, подключенной к разъему 
 (PEDAL 2). Редактирование может выполняться даже, когда для параметра «Pedal2 

Enable» выбрана установка «Off». Редактируемые параметры аналогичны описанным 
выше параметрам для «Pedal1 Edit >Ent».
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Другие полезные функции

Системные настройки

Помимо системных настроек, описанных в РУКОВОД-
СТВЕ ПОЛЬЗОВАТЕЛЯ (Основные сведения), могут 
быть настроены следующие параметры, также влияю-
щие на глобальные настройки цифрового пианино.
yy Функция микшера
yy Звукоряд
yy Регулировка чувствительности клавиатуры к силе на-
жатия

yy Фильтр сценических настроек
yy Функции MIDI
yy Информация о цифровом пианино (проверка версии 
системы во встроенной памяти, обновление встроен-
ного программного обеспечения)

Использование микшера

Микшер дает вам возможность регулировать тембр, уро-
вень громкости и другие настройки* партий источника 
звука цифрового пианино (партии с 01 по 16, партии 
внешнего устройства, стр. 5), просматривая баланс 
между партиями на дисплее.
* Настройки, влияющие на отдельные партии, называ-
ются «настройками партий», а настройки, влияющие на 
все партии, называются «общими настройками».

1.	 Нажмите кнопку  (SYS SETTING).

2.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( )  
 ( ) и  ( ) выберите пункт «Sound Generator».

3.	 Нажмите кнопку  (ENTER).

4.	 Измените настройку.
yy Для получения информации о пунктах настрой-
ки смотрите «Пункты настройки» (стр. 37).

5.	 После изменения настроек нажмите кнопку  (SYS 
SETTING) для выхода из экрана настройки.
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Пункты настройки

Индикация 
на дисплее

Описание Установки

Tuning Настройка. Регулирует с шагом в 0,1 Гц частоту ноты A4, являющейся базовой 
нотой для настройки.

415,5 - 465,9 Гц

Master Volume Общая громкость. Регулирует громкость всех партий 0 - 127

Master Pan Общее панорамирование. Регулирует позицию звука (слева/справа) в стереополе 
всех партий.

–64 - 0 - +63

External Volume Установка громкости внешнего источника. 0 - 127

Mixer Part1-16 
>Ent

Партии 1 - 16 микшера. Это пункты настройки для партий 1 - 16 микшера. Вы 
также можете использовать кнопки   (PART) «минус» (-) и «плюс» (+) для выбора 
партии.

Part Enable Включение/выключение партии. Включает или выключает каждую партию. Off, On

Tone

Тембр партии. Это тембр каждой партии. Используйте кнопки с  по  для пере-
ключения между категориями тембров.
yy Когда выбран этот параметр, вы можете выбрать тембр при помощи той же опе-

рации, которая используется в режиме выбора тембра.
yy Категория DRM (ударные инструменты) не может быть выбрана для зоны 2. 

DRM и HEX (Hex Layer) не могут быть выбраны для зоны 3 или зоны 4. При на-
жатии кнопки категории, которая не может быть выбрана, на дисплее отобража-
ется сообщение «Invalid Tone» [Неправильный тембр]. В этом случае дождитесь 
исчезновения сообщения или нажмите кнопку другой категории, чтобы убрать 
сообщение.

PNO (Фортепиано):
P00 - U39
EPN (Электропиано):
P000 - U109
ORG (Орган):
P00 - U49
STR (Струнные, мед-
ные духовые):
P00 - U89
GTR (Гитара, бас):
P00 - U59
VAR (Синтезатор,
разные): P000 - U129
DRM (Ударные):
P00 - U39
HEX (Hex Layer):
P000 - U199

Volume Громкость партии. Это установка громкости каждой партии. 0 - 127

Pan Панорамирование партии. Регулирует позицию звука (слева/справа) в стереополе. –64 - 0 - +63

Coarse Tune Грубая настройка партии. Изменяет высоту нот с шагом в полутон. –24 - 0 - +24

Fine Tune Точная настройка партии. Изменяет высоту нот с шагом в цент. –99 - 0 - +99

Bend Range
Диапазон изменения высоты тона партии. Задает (с шагом в полутон) максимальное 
изменение высоты звучания при повороте колеса  (BENDER).

0 - 24

Chorus Send
Посыл хоруса партии. Определяет, как применяется эффект хорус (стр. 18) к каждой 
партии.

0 - 127

Delay Send
Посыл дилэя партии. Определяет, как применяется эффект дилэй (стр. 18) к каждой 
партии.

0 - 127

Reverb Send
Посыл реверберации партии. Определяет, как применяется эффект реверберации 
(стр. 18) к каждой партии.

0 - 127

Resonance 
Send

Посыл резонанса. Включает/выключает посыл на эффект резонанса каждой партии 
микшера (стр. 18). Однако учтите, что эта настройка не может быть изменена для 
партий микшера, начиная с 5.

Off, On

Reso.Return 
Level

Уровень возврата резонанса. Регулирует уровень возврата резонанса для каждой пар-
тии микшера. Возможно редактирование только некоторых тембров. Учтите, что эта 
настройка не может быть изменена для партий микшера, начиная с 5.

0 - 127

Temperament 
>Ent

Звукоряд. Этот параметр задает звукоряд встроенного источника звука.

Type

Тип. Может быть выбран один из 17 приведенных ниже звукорядов.

00 - 16

00 : Equal
01 : Pure Major
02 : Pure Minor
03 : Pythagorean
04 : Kirnberger 3
05 : Werckmeister
06 : Mean-Tone
07 : Rast
08 : Bayati

09 : Hijaz
10 : Saba
11 : Dashti
12 : Chahargah
13 : Segah
14 : Gurjari Todi
15 : Chandrakauns
16 : Charukeshi

Root Основная нота. Задает основную ноту звукоряда. C - B
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Регулировка чувствительности 
клавиш к силе нажатия

Этот настройка регулирует степень и характер измене-
ния громкости и тембра звука в зависимости от силы 
нажатия на клавиши.

1.	 Нажмите кнопку  (SYS SETTING).

2.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( )  
 ( ) и  ( ) выберите пункт «General».

3.	 Нажмите кнопку  (ENTER).

4.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( )  
 ( ) и  ( ) выберите пункт настройки.

Пункты настройки

Индикация 
на дисплее

Описание Установки

Touch Чувствительность. Задает чув-
ствительность клавиатуры к силе 
нажатия.
Off: ноты звучат с фиксированным 
уровнем громкости вне зависимо-
сти от силы нажатия на клавиши.
Light: ноты звучат громко даже 
при слабом нажатии на клавиши.
Normal
Heavy: нормальное звучание 
производится при относительно 
сильном нажатии на клавиши.

См. ячей-
ку слева.

Touch Off 
Velo

Задает уровень громкости, при ко-
тором приведенные выше установ-
ки чувствительности не действуют.

1 - 127

5.	 Измените значение настройки.

6.	 После задания желаемых настроек нажмите кнопку  
(SYS SETTING), чтобы выйти из экрана настройки.

Фильтр сценических настроек

При вызове набора сценических настроек параметры 
цифрового пианино заменяются сценическим настрой-
ками. Если вы создадите фильтр сценических настроек, 
назначенные на фильтр параметры не заменяются при 
вызове набора сценических настроек, а сохраняют своих 
текущие значения.

1.	 Нажмите кнопку  (SYS SETTING).

2.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( )  
 ( ) и  ( ) выберите пункт «General».

3.	 Нажмите кнопку  (ENTER).

4.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( )  
 ( ) и  ( ) выберите пункт «Stage Set Filter».

5.	 Нажмите кнопку  (ENTER).

6.	 При помощи кнопки  ( ) выберите пункт настройки, 
а затем нажмите кнопку  (ENTER).
yy При помощи кнопок  «минус» (-) и «плюс» 
(+) выберите «Off» (для разрешения изменения 
пункта настройки) или «On» (для запрещения 
изменения пункта настройки).

Пункты настройки

Индикация 
на дисплее

Описание Установки

Tempo Темп. В случае выбора установки 
«On» вызов параметров темпа (стр. 
34) не выполняется.

Off, On

Arpeggio Арпеджио. В случае выбора уста-
новки «On» вызов параметров ар-
педжио (стр. 34) не выполняется.

Off, On

Phrase Фраза. В случае выбора установки 
«On» вызов параметров фразы 
(стр. 34) не выполняется.

Off, On

Hammer 
Response

Отклик молоточков. В случае 
выбора установки «On» вызов 
параметров отклика молоточков 
(стр. 34) не выполняется.

Off, On

Chorus Системный хорус. В случае выбо-
ра установки «On» вызов параме-
тров системного хоруса (стр. 23) 
не выполняется.

Off, On

Delay Системный дилэй. В случае выбора 
установки «On» вызов параметров 
системного дилэя (стр. 23) не вы-
полняется.

Off, On
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Индикация 
на дисплее

Описание Установки

Reverb Системная реверберация. В случае 
выбора установки «On» вызов па-
раметров системной реверберации 
(стр. 23) не выполняется.

Off, On

Compressor Мастер-компрессор. В случае 
выбора установки «On» вызов 
параметров мастер-компрессора 
(стр. 23) не выполняется.

Off, On

Equalizer Мастер-эквалайзер. В случае 
выбора установки «On» вызов па-
раметров мастер-эквалайзера (стр. 
23) не выполняется.

Off, On

Pedal1 Педаль 1. В случае выбора уста-
новки «On» вызов параметров 
педали 1 (стр. 32) не выполняется.
yy Для установок «Stage Inc» и 

«Stage Dec» эта операция всегда 
выполняется вне зависимости 
от сценических настроек.

Off, On, 
Stage Inc, 
Stage Dec

Pedal2 Педаль 2. Настройки аналогичны 
пункту «Pedal1» выше.

7.	 После задания желаемых настроек нажмите кнопку  
(SYS SETTING), чтобы выйти из экрана настройки.

Использование MIDI

Что такое MIDI?

MIDI – это стандарт для цифровых сигналов и соедини-
тельных устройств, который делает возможным обмен 
музыкальными данными между музыкальными инстру-
ментами, компьютерами и другими устройствами, выпу-
щенными разными производителями.
Для получения подробной информации о специфика-
ции MIDI данного цифрового пианино смотрите до-
кумент «Внедрение MIDI» на веб-сайте по следующему 
URL-адресу.
http://world.casio.com/

ПРИМЕЧАНИЕ

yy Используйте приобретаемый отдельно MIDI-кабель 
для соединения MIDI-разъемов вашего цифрового 
пианино с другим электронным музыкальным инстру-
ментом для обмена MIDI-данными.

yy Для получения информации о взаимосвязи между 
каждой партией цифрового пианино (стр. 36) и кана-
лами MIDI IN и MIDI OUT смотрите раздел «Как от-
редактировать набор сценических настроек» (стр. 31).

yy Данное цифровое пианино соответствует стандарту 
General MIDI Level 1 (GM).

Настройки MIDI

1.	 Нажмите кнопку  (SYS SETTING).

2.	 Выберите «MIDI >Ent», а затем нажмите кнопку   
(ENTER).

3.	 Измените настройку.
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Пункты настройки

Индикация на дисплее Описание Установки

Transpose Транспонирование. Изменяет высоту нот с шагом в полутон. –12 - 0 - +12

Octave Shift Октавный перенос. Изменяет высоту нот с шагом в октаву. –3 - 0 - +3

Local Control Локальное управление. Выключение локального управления от-
ключает встроенный источник звука цифрового пианино, поэтому 
при нажатии клавиш клавиатуры звук не производится. Выключайте 
локальное управление, когда вы хотите использовать клавиатуру и 
педали цифрового пианино для управления внешним источником 
звука, чтобы само цифровое пианино при этом не звучало.

Off, On

High Reso Out Включение/выключение отправки MIDI-сообщения о динамической 
чувствительности высокого разрешения.

Off, On

Device ID Идентификатор устройства. Выбирает идентификационный номер 
цифрового пианино для отправки/приема специального системного 
MIDI-сообщения.
yy Когда выбрана установка «ALL», специальное системное сообще-

ние посылается вне зависимости от идентификационного номера.
yy Для получения подробной информации об идентификационном 

номере см. Карту внедрения MIDI по адресу http://world.casio.com/.

1 - 16, ALL

Basic Ch Основной канал. Задает приемный канал сообщения «Stage Set.Chg» 
и других MIDI-сообщений, описанных ниже.

1 - 16

MIDI Out Select Выбор выхода MIDI. Задает, что подается на выход MIDI.
KEY (клавиатура): игра на клавиатуре цифрового пианино, операции 
органов управления и т.д.
MIDI (MIDI IN): сообщения, принятые через разъем  (MIDI IN) 
(режим сквозной передачи MIDI-сообщений) 
USB (USB IN): сообщения, принятые через разъем  (USB)

См. ячейку слева.

USB Out Select Выбор выхода USB. Задает, что подается на выход USB.
KEY (клавиатура): игра на клавиатуре и другие операции цифрового 
пианино.
MIDI (MIDI IN): сообщения, принятые через разъем  (MIDI IN)

См. ячейку слева.

MIDI In Enable Включение/выключение приема MIDI. Когда этот параметр вклю-
чен, сообщения, принимаемые через разъем  (MIDI IN), отражают-
ся на встроенном источнике звука цифрового пианино.

Off, On

USB In Enable Включение/выключение приема USB. Когда этот параметр включен, 
сообщения, принимаемые через разъем  (USB), отражаются на 
встроенном источнике звука цифрового пианино.

Off, On

Sync Mode Режим синхронизации. Настройки для MIDI-синхронизации между 
цифровым пианино и внешним устройством.
Off: нет синхронизации.
Master: отправляет синхронизирующие сигналы, сигналы запуска/
остановки (песенного секвенсора) и другие сигналы с цифрового 
пианино для управления внешним устройством.
Slave: принимает синхронизирующие сигналы, сигналы запуска/
остановки и другие сигналы с внешнего устройства.
yy Воспроизведение данных песенного секвенсора не может быть 

выполнено, если не получен синхронизирующий сигнал. Запуск/
остановки считается операцией песенного секвенсора.

См. ячейку слева.

Stage Set.Chg Изменение сценических настроек.
PrgBnk: банк смены программы = 70H. Также передается при выпол-
нении этой операции.
NRPN: выбор NRPN MSB = 24H, LSB = 00H. Также передается при 
выполнении этой операции.

PrgBnk, NRPN
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4.	 После задания желаемых настроек нажмите кнопку  
(SYS SETTING), чтобы выйти из экрана настройки.

ПРИМЕЧАНИЕ

yy Вы также можете использовать редактирование сце-
нических настроек для изменения канала передачи 
MIDI-данных и настройки других параметров. Для 
получения более подробной информации смотрите 
группу параметров «MIDI Edit >Ent» (стр. 33).

Информация о цифровом пианино

Вы можете использовать экран информации о настрой-
ках системы (Information) для проверки версии системы, 
загруженной в память цифрового пианино, и обновле-
ния встроенного программного обеспечения.

1.	 Нажмите кнопку  (SYS SETTING).

2.	 При помощи кнопок  ( ),  ( ),  ( ) и  ( )  
 ( ) и  ( ) выберите пункт «Information».

3.	 Нажмите кнопку  (ENTER).

4.	 При помощи кнопки  ( ) выберите пункт настройки, 
а затем нажмите кнопку  (ENTER).
Version: проверяет версию системы в памяти циф-
рового пианино.
yy Это только проверка, поэтому установки отсут-
ствуют.

yy Update Firmware: обновляет встроенное про-
граммное обеспечение.

yy Для получения информации о последней версии 
встроенного программного обеспечения и о про-
цедуре обновления посетите веб-сайт по следую-
щему адресу. 
http://world.casio.com/

5.	 После задания желаемых настроек нажмите кнопку  
(SYS SETTING), чтобы выйти из экрана настройки.
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Перечень тембров

Название
группы

 

№ Название тембра
Индикация
на дисплее

Отправка и прием Только прием

Смена
программы

Старший
бит

выбора
банка

Смена
программы

Старший
бит

выбора
банка

PIANO 000
GRAND PIANO 
CONCERT

GrPnoConcert 0 64 0 48

PIANO 001 ROCK PIANO Rock Piano 1 64 1 48

PIANO 002
GRAND PIANO 
STUDIO

GrPno Studio 2 64 0 54

PIANO 003
GRAND PIANO 
MODERN

GrPno Modern 3 64 0 49

PIANO 004 LA PIANO LA Piano 4 64 1 49

PIANO 005 DANCE PIANO Dance Piano 5 64 1 50

PIANO 006
GRAND PIANO 
BRIGHT

GrPno Bright 6 64 1 51

PIANO 007
GRAND PIANO 
MELLOW

GrPno Mellow 7 64 0 51

PIANO 008 MONO PIANO 1 Mono Piano 1 8 64 0 56

PIANO 009 MONO PIANO 2 Mono Piano 2 9 64 0 57

PIANO 010 TACK PIANO Tack Piano 10 64 0 58

PIANO 011
GRAND PIANO 
CLASSIC

GrPnoClassic 11 64 0 50

PIANO 012
GRAND PIANO 
DOLCE

GrPianoDolce 12 64 0 55

PIANO 013 HONKY-TONK Honky-Tonk 13 64 3 48

PIANO 014 OCTAVE PIANO Octave Piano 14 64 3 49

PIANO 015 STRINGS PIANO StringsPiano 15 64 0 52

PIANO 016 PIANO PAD Piano Pad 16 64 0 53

PIANO 017 GM PIANO 1 GM Piano 1 17 64 0 0

PIANO 018 GM PIANO 2 GM Piano 2 18 64 1 0

PIANO 019 GM HONKY-TONK GM HonkyTonk 19 64 3 0

PIANO
020 - 
039

User Tones 20 - 39 64

ELEC 
PIANO

000 AiR ELEC.PIANO 1 AiR E.Piano1 0 65 4 40

ELEC 
PIANO

001 AiR ELEC.PIANO 2 AiR E.Piano2 1 65 4 41

ELEC 
PIANO

002 AiR ELEC.PIANO 3 AiR E.Piano3 2 65 4 42

ELEC 
PIANO

003 AiR ELEC.PIANO 4 AiR E.Piano4 3 65 4 43

ELEC 
PIANO

004 AiR ELEC.PIANO 5 AiR E.Piano5 4 65 4 44

ELEC 
PIANO

005 AiR 60’S E.PIANO 1 AiR 60’s EP1 5 65 4 45

ELEC 
PIANO

006 AiR 60’S E.PIANO 2 AiR 60’s EP2 6 65 4 46

ELEC 
PIANO

007 AiR 60’S E.PIANO 3 AiR 60’s EP3 7 65 4 47

ELEC 
PIANO

008 AiR 60’S E.PIANO 4 AiR 60’s EP4 8 65 4 48

ELEC 
PIANO

009 ELEC.PIANO 1 Elec.Piano 1 9 65 4 49

ELEC 
PIANO

010 ELEC.PIANO 2 Elec.Piano 2 10 65 4 50

ELEC 
PIANO

011 ELEC.PIANO 3 Elec.Piano 3 11 65 4 51

ELEC 
PIANO

012 ELEC.PIANO 4 Elec.Piano 4 12 65 4 52

ELEC 
PIANO

013 ELEC.PIANO 5 Elec.Piano 5 13 65 4 53

ELEC 
PIANO

014 DIGITAL E.PIANO 1 Digital EP 1 14 65 5 48

ELEC 
PIANO

015 DIGITAL E.PIANO 2 Digital EP 2 15 65 5 49

ELEC 
PIANO

016 DIGITAL E.PIANO 3 Digital EP 3 16 65 5 50

ELEC 
PIANO

017 DIGITAL E.PIANO 4 Digital EP 4 17 65 5 51

ELEC 
PIANO

018 DIGITAL E.PIANO 5 Digital EP 5 18 65 5 52

ELEC 
PIANO

019 DIGITAL E.PIANO 6 Digital EP 6 19 65 5 53

ELEC 
PIANO

020 DIGITAL E.PIANO 7 Digital EP 7 20 65 5 54

ELEC 
PIANO

021 DIGITAL E.PIANO 8 Digital EP 8 21 65 5 55

ELEC 
PIANO

022 DIGITAL E.PIANO 9 Digital EP 9 22 65 5 56

ELEC 
PIANO

023 DYNO ELEC.PIANO 1 DynoE.Piano1 23 65 4 54

ELEC 
PIANO

024 DYNO ELEC.PIANO 2 DynoE.Piano2 24 65 4 55

ELEC 
PIANO

025 60’S ELEC.PIANO 1 60’sE.Piano1 25 65 4 56

ELEC 
PIANO

026 60’S ELEC.PIANO 2 60’sE.Piano2 26 65 4 57

ELEC 
PIANO

027 PHASER E.PIANO 1 Phaser EP 1 27 65 4 58

ELEC 
PIANO

028 PHASER E.PIANO 2 Phaser EP 2 28 65 4 59

ELEC 
PIANO

029 AMP E.PIANO 1 Amp E.Piano1 29 65 4 60

ELEC 
PIANO

030 AMP E.PIANO 2 Amp E.Piano2 30 65 4 61

ELEC 
PIANO

031 CRUNCH E.PIANO Crunch EP 31 65 4 62

ELEC 
PIANO

032 DIZZY E.PIANO Dizzy EP 32 65 4 63

ELEC 
PIANO

033 ANALOG E.PIANO 1 Analog EP 1 33 65 5 57

ELEC 
PIANO

034 ANALOG E.PIANO 2 Analog EP 2 34 65 5 58

ELEC 
PIANO

035 OFF VELO.CLAVI 1 OffVelClavi1 35 65 7 48

ELEC 
PIANO

036 OFF VELO.CLAVI 2 OffVelClavi2 36 65 7 49

ELEC 
PIANO

037 CLAVI 1 Clavi 1 37 65 7 50

ELEC 
PIANO

038 CLAVI 2 Clavi 2 38 65 7 51

ELEC 
PIANO

039 CLAVI 3 Clavi 3 39 65 7 52

ELEC 
PIANO

040 CLAVI 4 Clavi 4 40 65 7 53

ELEC 
PIANO

041 WAH CLAVI 1 Wah Clavi 1 41 65 7 54

ELEC 
PIANO

042 WAH CLAVI 2 Wah Clavi 2 42 65 7 55

ELEC 
PIANO

043 CRUNCH CLAVI Crunch Clavi 43 65 7 56

ELEC 
PIANO

044
OFF 
VELO.HARPSICHORD

OffVelHarpsi 44 65 6 48

ELEC 
PIANO

045 HARPSICHORD Harpsichord 45 65 6 49

ELEC 
PIANO

046
COUPLED 
HARPSICHORD

Coupl.Harpsi 46 65 6 50

ELEC 
PIANO

047 VIBRAPHONE Vibraphone 47 65 11 48

ELEC 
PIANO

048 GM E.PIANO 1 GM E.Piano 1 48 65 4 0

ELEC 
PIANO

049 GM E.PIANO 2 GM E.Piano 2 49 65 5 0

ELEC 
PIANO

050
GM ELEC.GRAND 
PIANO

GM E.G.Piano 50 65 2 0

ELEC 
PIANO

051 GM HARPSICHORD GM Harpsi. 51 65 6 0

ELEC 
PIANO

052 GM CLAVI GM Clavi 52 65 7 0

ELEC 
PIANO

053 GM CELESTA GM Celesta 53 65 8 0

ELEC 
PIANO

054 GM GLOCKENSPIEL GM Glocken. 54 65 9 0

ELEC 
PIANO

055 GM MUSIC BOX GM Music Box 55 65 10 0

ELEC 
PIANO

056 GM VIBRAPHONE GM Vibraphon 56 65 11 0

ELEC 
PIANO

057 GM MARIMBA GM Marimba 57 65 12 0

ELEC 
PIANO

058 GM XYLOPHONE GM Xylophone 58 65 13 0

ELEC 
PIANO

059 GM TUBULAR BELL GM TublarBel 59 65 14 0

ELEC 
PIANO

060 - 
109

User Tones 60 - 109 65

ORGAN 000 ROCK ORGAN 1 Rock Organ 1 0 66 16 49

ORGAN 001 ROCK ORGAN 2 Rock Organ 2 1 66 18 48

ORGAN 002 ROCK ORGAN 3 Rock Organ 3 2 66 18 49

ORGAN 003 JAZZ ORGAN 1 Jazz Organ 1 3 66 17 48

ORGAN 004 JAZZ ORGAN 2 Jazz Organ 2 4 66 17 51

ORGAN 005 PERC.ORGAN 1 Perc.Organ 1 5 66 17 49

ORGAN 006 PERC.ORGAN 2 Perc.Organ 2 6 66 17 52

ORGAN 007 PERC.ORGAN 3 Perc.Organ 3 7 66 17 53

ORGAN 008 DRAWBAR ORGAN 1 Drawbar Org1 8 66 16 48

ORGAN 009 DRAWBAR ORGAN 2 Drawbar Org2 9 66 16 50

ORGAN 010 DRAWBAR ORGAN 3 Drawbar Org3 10 66 16 51

ORGAN 011 ELEC.ORGAN 1 Elec.Organ 1 11 66 16 54

ORGAN 012 ELEC.ORGAN 2 Elec.Organ 2 12 66 16 55

ORGAN 013 ELEC.ORGAN 3 Elec.Organ 3 13 66 16 56

ORGAN 014 70’S ORGAN 70’s Organ 14 66 17 50

ORGAN 015 OVERDRIVE ORGAN 1 OverdrivOrg1 15 66 16 52

ORGAN 016 OVERDRIVE ORGAN 2 OverdrivOrg2 16 66 16 57

ORGAN 017 TREMOLO ORGAN Tremolo Org 17 66 16 53

ORGAN 018 CLICK ORGAN Click Organ 18 66 17 54

ORGAN 019 SEQUENCE ORGAN Seq.Organ 19 66 17 55

ORGAN 020 GOSPEL ORGAN Gospel Organ 20 66 17 56

ORGAN 021 CHAPEL ORGAN Chapel Organ 21 66 19 49

Название
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ORGAN 022 GM ORGAN 1 GM Organ 1 22 66 16 0

ORGAN 023 GM ORGAN 2 GM Organ 2 23 66 17 0

ORGAN 024 GM ORGAN 3 GM Organ 3 24 66 18 0

ORGAN 025 GM PIPE ORGAN GM PipeOrgan 25 66 19 0

ORGAN 026 GM REED ORGAN GM ReedOrgan 26 66 20 0

ORGAN 027 GM ACCORDION GM Accordion 27 66 21 0

ORGAN 028 GM HARMONICA GM Harmonica 28 66 22 0

ORGAN 029 GM BANDONEON GM Bandoneon 29 66 23 0

ORGAN
030 - 
049

User Tones User 90 30 - 49 66

STRINGS/
BRASS

000 STEREO STRINGS 1 StreoString1 0 67 49 48

STRINGS/
BRASS

001 STEREO STRINGS 2 StreoString2 1 67 48 49

STRINGS/
BRASS

002 STRING ENSEMBLE String Ens. 2 67 48 48

STRINGS/
BRASS

003 SLOW STRINGS Slow Strings 3 67 49 49

STRINGS/
BRASS

004 BRIGHT STRINGS BriteStrings 4 67 48 50

STRINGS/
BRASS

005 WARM STRINGS Warm Strings 5 67 48 51

STRINGS/
BRASS

006 SYNTH-STRINGS 1 Syn-Strings1 6 67 50 48

STRINGS/
BRASS

007 SYNTH-STRINGS 2 Syn-Strings2 7 67 51 48

STRINGS/
BRASS

008 SYNTH-STRINGS 3 Syn-Strings3 8 67 51 49

STRINGS/
BRASS

009 70’S SYNTH-STR. 70’s Syn-Str 9 67 50 49

STRINGS/
BRASS

010 80’S SYNTH-STR. 80’s Syn-Str 10 67 50 50

STRINGS/
BRASS

011 VIOLIN SECTION ViolnSection 11 67 40 48

STRINGS/
BRASS

012 ORCHESTRA PAD OrchestraPad 12 67 48 52

STRINGS/
BRASS

013 CHOIR Choir 13 67 52 48

STRINGS/
BRASS

014 SYNTH-VOICE 1 Synth-Voice1 14 67 54 48

STRINGS/
BRASS

015 SYNTH-VOICE 2 Synth-Voice2 15 67 54 49

STRINGS/
BRASS

016 VOICE ENSEMBLE VoiceEnsembl 16 67 54 50

STRINGS/
BRASS

017 SYNTH-VOICE PAD SynVoice Pad 17 67 54 51

STRINGS/
BRASS

018 STEREO BRASS Stereo Brass 18 67 61 48

STRINGS/
BRASS

019 BRASS SECTION BrassSection 19 67 61 49

STRINGS/
BRASS

020 SYNTH-BRASS 1 Syn-Brass 1 20 67 62 48

STRINGS/
BRASS

021 SYNTH-BRASS 2 Syn-Brass 2 21 67 63 48

STRINGS/
BRASS

022 80’S SYNTH-BRASS 80’sSynBrass 22 67 62 49

STRINGS/
BRASS

023 BRASS ENSEMBLE Brass Ens. 23 67 61 50

STRINGS/
BRASS

024 BREATHY ALTO SAX Breathy ASax 24 67 65 49

STRINGS/
BRASS

025 BREATHY TENOR SAX Breathy TSax 25 67 66 49

STRINGS/
BRASS

026 ALTO SAX Alto Sax 26 67 65 48

STRINGS/
BRASS

027 TENOR SAX Tenor Sax 27 67 66 48

STRINGS/
BRASS

028 FLUTE Flute 28 67 73 48

STRINGS/
BRASS

029 TRUMPET Trumpet 29 67 56 48

STRINGS/
BRASS

030 GM VIOLIN GM Violin 30 67 40 0

STRINGS/
BRASS

031 GM VIOLA GM Viola 31 67 41 0

STRINGS/
BRASS

032 GM CELLO GM Cello 32 67 42 0

STRINGS/
BRASS

033 GM CONTRABASS GM Contrabas 33 67 43 0

STRINGS/
BRASS

034
GM TREMOLO 
STRINGS

GM Trem.Str. 34 67 44 0

STRINGS/
BRASS

035 GM PIZZICATO GM Pizzicato 35 67 45 0

STRINGS/
BRASS

036 GM HARP GM Harp 36 67 46 0

STRINGS/
BRASS

037 GM TIMPANI GM Timpani 37 67 47 0

STRINGS/
BRASS

038 GM STRINGS 1 GM Strings 1 38 67 48 0

STRINGS/
BRASS

039 GM STRINGS 2 GM Strings 2 39 67 49 0

STRINGS/
BRASS

040 GM SYNTH-STRINGS 1 GM Syn-Str.1 40 67 50 0

STRINGS/
BRASS

041 GM SYNTH-STRINGS 2 GM Syn-Str.2 41 67 51 0

STRINGS/
BRASS

042 GM CHOIR AAHS GM ChoirAahs 42 67 52 0

Название
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STRINGS/
BRASS

043 GM VOICE DOO GM Voice Doo 43 67 53 0

STRINGS/
BRASS

044 GM SYNTH-VOICE GM Syn-Voice 44 67 54 0

STRINGS/
BRASS

045 GM ORCHESTRA HIT GM Orch.Hit 45 67 55 0

STRINGS/
BRASS

046 GM TRUMPET GM Trumpet 46 67 56 0

STRINGS/
BRASS

047 GM TROMBONE GM Trombone 47 67 57 0

STRINGS/
BRASS

048 GM TUBA GM Tuba 48 67 58 0

STRINGS/
BRASS

049 GM MUTE TRUMPET GM MtTrumpet 49 67 59 0

STRINGS/
BRASS

050 GM FRENCH HORN GM Fr.Horn 50 67 60 0

STRINGS/
BRASS

051 GM BRASS GM Brass 51 67 61 0

STRINGS/
BRASS

052 GM SYNTH-BRASS 1 GM SynBrass1 52 67 62 0

STRINGS/
BRASS

053 GM SYNTH-BRASS 2 GM SynBrass2 53 67 63 0

STRINGS/
BRASS

054 GM SOPRANO SAX GM Sop.Sax 54 67 64 0

STRINGS/
BRASS

055 GM ALTO SAX GM Alto Sax 55 67 65 0

STRINGS/
BRASS

056 GM TENOR SAX GM Tenor Sax 56 67 66 0

STRINGS/
BRASS

057 GM BARITONE SAX GM Bar.Sax 57 67 67 0

STRINGS/
BRASS

058 GM OBOE GM Oboe 58 67 68 0

STRINGS/
BRASS

059 GM ENGLISH HORN GM Eng.Horn 59 67 69 0

STRINGS/
BRASS

060 GM BASSOON GM Bassoon 60 67 70 0

STRINGS/
BRASS

061 GM CLARINET GM Clarinet 61 67 71 0

STRINGS/
BRASS

062 GM PICCOLO GM Piccolo 62 67 72 0

STRINGS/
BRASS

063 GM FLUTE GM Flute 63 67 73 0

STRINGS/
BRASS

064 GM RECORDER GM Recorder 64 67 74 0

STRINGS/
BRASS

065 GM PAN FLUTE GM Pan Flute 65 67 75 0

STRINGS/
BRASS

066 GM BOTTLE BLOW GM BotleBlow 66 67 76 0

STRINGS/
BRASS

067 GM SHAKUHACHI GM Shakuhach 67 67 77 0

STRINGS/
BRASS

068 GM WHISTLE GM Whistle 68 67 78 0

STRINGS/
BRASS

069 GM OCARINA GM Ocarina 69 67 79 0

STRINGS/
BRASS

070 - 
089

User Tones 70 - 89 67

GUITAR/
BASS

000 ACOUSTIC BASS 1 Acous.Bass 1 0 68 32 48

GUITAR/
BASS

001 ACOUSTIC BASS 2 Acous.Bass 2 1 68 32 49

GUITAR/
BASS

002 RIDE BASS Ride Bass 2 68 32 50

GUITAR/
BASS

003 FINGERED BASS 1 FingerBass 1 3 68 33 48

GUITAR/
BASS

004 FINGERED BASS 2 FingerBass 2 4 68 33 49

GUITAR/
BASS

005 FINGERED BASS 3 FingerBass 3 5 68 34 50

GUITAR/
BASS

006 PICKED BASS Picked Bass 6 68 34 48

GUITAR/
BASS

007 SYNTH-BASS 1 Synth-Bass 1 7 68 38 48

GUITAR/
BASS

008 SYNTH-BASS 2 Synth-Bass 2 8 68 38 49

GUITAR/
BASS

009 SYNTH-BASS 3 Synth-Bass 3 9 68 38 50

GUITAR/
BASS

010 SYNTH-BASS 4 Synth-Bass 4 10 68 39 48

GUITAR/
BASS

011 SYNTH-BASS 5 Synth-Bass 5 11 68 39 49

GUITAR/
BASS

012 SYNTH-BASS 6 Synth-Bass 6 12 68 39 50

GUITAR/
BASS

013 TRANCE BASS Trance Bass 13 68 38 51

GUITAR/
BASS

014 NYLON STR.GUITAR Nylon Guitar 14 68 24 48

GUITAR/
BASS

015 STEEL STR.GUITAR Steel Guitar 15 68 25 48

GUITAR/
BASS

016 JAZZ GUITAR Jazz Guitar 16 68 26 48

GUITAR/
BASS

017 CLEAN GUITAR Clean Guitar 17 68 27 49

GUITAR/
BASS

018
CHORUS CLEAN 
GUITAR

Cho.CleanGt 18 68 27 48

GUITAR/
BASS

019
CRUNCH 
ELEC.GUITAR

Crunch E.Gt 19 68 27 50
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GUITAR/
BASS

020 OVERDRIVE GUITAR 1 Overdrive Gt 20 68 29 48

GUITAR/
BASS

021 MUTE OVERDRIVE GT Mute Ovd Gt 21 68 28 48

GUITAR/
BASS

022 OVERDRIVE GUITAR 2 Overdrive G2 22 68 28 49

GUITAR/
BASS

023 DISTORTION GT DistortionGt 23 68 30 48

GUITAR/
BASS

024
GM NYLON 
STR.GUITAR

GM Nylon Gt 24 68 24 0

GUITAR/
BASS

025
GM STEEL 
STR.GUITAR

GM Steel Gt 25 68 25 0

GUITAR/
BASS

026 GM JAZZ GUITAR GM Jazz Gt 26 68 26 0

GUITAR/
BASS

027 GM CLEAN GUITAR GM Clean Gt 27 68 27 0

GUITAR/
BASS

028 GM MUTE GUITAR GM Mute Gt 28 68 28 0

GUITAR/
BASS

029 GM OVERDRIVE GT GM Overdrive 29 68 29 0

GUITAR/
BASS

030 GM DISTORTION GT GM Dist.Gt 30 68 30 0

GUITAR/
BASS

031 GM GT HARMONICS GM Gt Harm. 31 68 31 0

GUITAR/
BASS

032 GM ACOUSTIC BASS GM AcousBass 32 68 32 0

GUITAR/
BASS

033 GM FINGERED BASS GM Finger Bs 33 68 33 0

GUITAR/
BASS

034 GM PICKED BASS GM Pick Bass 34 68 34 0

GUITAR/
BASS

035 GM FRETLESS BASS GM FretlesBs 35 68 35 0

GUITAR/
BASS

036 GM SLAP BASS 1 GM SlapBass1 36 68 36 0

GUITAR/
BASS

037 GM SLAP BASS 2 GM SlapBass2 37 68 37 0

GUITAR/
BASS

038 GM SYNTH-BASS 1 GM Syn-Bass1 38 68 38 0

GUITAR/
BASS

039 GM SYNTH-BASS 2 GM Syn-Bass2 39 68 39 0

GUITAR/
BASS

040 - 
059

User Tones 40 - 59 68

SYNTH/
VARIOUS

000 SAW LEAD 1 Saw Lead 1 0 69 81 48

SYNTH/
VARIOUS

001 SAW LEAD 2 Saw Lead 2 1 69 81 49

SYNTH/
VARIOUS

002 SAW LEAD 3 Saw Lead 3 2 69 81 50

SYNTH/
VARIOUS

003 MELLOW SAW LEAD MelowSawLead 3 69 81 51

SYNTH/
VARIOUS

004 SQUARE LEAD 1 Square Lead1 4 69 80 48

SYNTH/
VARIOUS

005 SQUARE LEAD 2 Square Lead2 5 69 80 49

SYNTH/
VARIOUS

006 PULSE LEAD 1 Pulse Lead 1 6 69 80 51

SYNTH/
VARIOUS

007 PULSE LEAD 2 Pulse Lead 2 7 69 80 52

SYNTH/
VARIOUS

008 SINE LEAD Sine Lead 8 69 80 53

SYNTH/
VARIOUS

009
SQUARE PULSE 
LEAD

Sqr Pulse Ld 9 69 80 59

SYNTH/
VARIOUS

010 VA SYNTH 1 VA Synth 1 10 69 80 54

SYNTH/
VARIOUS

011 VA SYNTH 2 VA Synth 2 11 69 80 55

SYNTH/
VARIOUS

012 VA SYNTH 3 VA Synth 3 12 69 80 56

SYNTH/
VARIOUS

013 VA SYNTH 4 VA Synth 4 13 69 80 57

SYNTH/
VARIOUS

014 VA SYNTH 5 VA Synth 5 14 69 80 58

SYNTH/
VARIOUS

015 SEQUENCE SAW Sequence Saw 15 69 81 55

SYNTH/
VARIOUS

016 SAW ARPEGGIO Saw Arpeggio 16 69 81 56

SYNTH/
VARIOUS

017
VA SYNTH 
SEQ-BASS 1

VA SynSeqBs1 17 69 81 52

SYNTH/
VARIOUS

018
VA SYNTH 
SEQ-BASS 2

VA SynSeqBs2 18 69 81 53

SYNTH/
VARIOUS

019
VA SYNTH 
SEQ-BASS 3

VA SynSeqBs3 19 69 81 54

SYNTH/
VARIOUS

020 FANTASY Fantasy 20 69 88 48

SYNTH/
VARIOUS

021 NEW AGE New Age 21 69 88 49

SYNTH/
VARIOUS

022 WARM PAD Warm Pad 22 69 89 48

SYNTH/
VARIOUS

023 WARM VOX Warm Vox 23 69 89 49

SYNTH/
VARIOUS

024 POLYSYNTH PAD PolysynthPad 24 69 90 48

SYNTH/
VARIOUS

025 SYNTH-PAD Syn-Pad 25 69 90 49

SYNTH/
VARIOUS

026 BRIGHT SAW PAD BrightSawPad 26 69 90 50

Название
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SYNTH/
VARIOUS

027 ATMOSPHERE PAD AtmspherePad 27 69 99 48

SYNTH/
VARIOUS

028 VA SYNTH-PAD 1 VA Syn-Pad 1 28 69 90 51

SYNTH/
VARIOUS

029 VA SYNTH-PAD 2 VA Syn-Pad 2 29 69 90 52

SYNTH/
VARIOUS

030 VA SYNTH-PAD 3 VA Syn-Pad 3 30 69 90 53

SYNTH/
VARIOUS

031 GM SQUARE LEAD GM Squ.Lead 31 69 80 0

SYNTH/
VARIOUS

032 GM SAW LEAD GM Saw Lead 32 69 81 0

SYNTH/
VARIOUS

033 GM CALLIOPE GM Calliope 33 69 82 0

SYNTH/
VARIOUS

034 GM CHIFF LEAD GM ChiffLead 34 69 83 0

SYNTH/
VARIOUS

035 GM CHARANG GM Charang 35 69 84 0

SYNTH/
VARIOUS

036 GM VOICE LEAD GM VoiceLead 36 69 85 0

SYNTH/
VARIOUS

037 GM FIFTH LEAD GM FifthLead 37 69 86 0

SYNTH/
VARIOUS

038 GM BASS+LEAD GM Bass+Lead 38 69 87 0

SYNTH/
VARIOUS

039 GM FANTASY GM Fantasy 39 69 88 0

SYNTH/
VARIOUS

040 GM WARM PAD GM Warm Pad 40 69 89 0

SYNTH/
VARIOUS

041 GM POLYSYNTH GM PolySynth 41 69 90 0

SYNTH/
VARIOUS

042 GM SPACE CHOIR GM Space Cho 42 69 91 0

SYNTH/
VARIOUS

043 GM BOWED GLASS GM Bow Glass 43 69 92 0

SYNTH/
VARIOUS

044 GM METAL PAD GM Metal Pad 44 69 93 0

SYNTH/
VARIOUS

045 GM HALO PAD GM Halo Pad 45 69 94 0

SYNTH/
VARIOUS

046 GM SWEEP PAD GM Sweep Pad 46 69 95 0

SYNTH/
VARIOUS

047 GM RAIN DROP GM Rain Drop 47 69 96 0

SYNTH/
VARIOUS

048 GM SOUND TRACK GM SoundTrak 48 69 97 0

SYNTH/
VARIOUS

049 GM CRYSTAL GM Crystal 49 69 98 0

SYNTH/
VARIOUS

050 GM ATMOSPHERE GM Atmosphre 50 69 99 0

SYNTH/
VARIOUS

051 GM BRIGHTNESS GM Brightnes 51 69 100 0

SYNTH/
VARIOUS

052 GM GOBLINS GM Goblins 52 69 101 0

SYNTH/
VARIOUS

053 GM ECHOES GM Echoes 53 69 102 0

SYNTH/
VARIOUS

054 GM SF GM SF 54 69 103 0

SYNTH/
VARIOUS

055 GM SITAR GM Sitar 55 69 104 0

SYNTH/
VARIOUS

056 GM BANJO GM Banjo 56 69 105 0

SYNTH/
VARIOUS

057 GM SHAMISEN GM Shamisen 57 69 106 0

SYNTH/
VARIOUS

058 GM KOTO GM Koto 58 69 107 0

SYNTH/
VARIOUS

059 GM THUMB PIANO GM Thumb Pno 59 69 108 0

SYNTH/
VARIOUS

060 GM BAGPIPE GM Bagpipe 60 69 109 0

SYNTH/
VARIOUS

061 GM FIDDLE GM Fiddle 61 69 110 0

SYNTH/
VARIOUS

062 GM SHANAI GM Shanai 62 69 111 0

SYNTH/
VARIOUS

063 GM DULCIMER GM Dulcimer 63 69 15 0

SYNTH/
VARIOUS

064 GM TINKLE BELL GM TinkleBel 64 69 112 0

SYNTH/
VARIOUS

065 GM AGOGO GM Agogo 65 69 113 0

SYNTH/
VARIOUS

066 GM STEEL DRUMS GM SteelDrum 66 69 114 0

SYNTH/
VARIOUS

067 GM WOOD BLOCK GM WoodBlock 67 69 115 0

SYNTH/
VARIOUS

068 GM TAIKO GM Taiko 68 69 116 0

SYNTH/
VARIOUS

069 GM MELODIC TOM GM Melo.Tom 69 69 117 0

SYNTH/
VARIOUS

070 GM SYNTH-DRUM GM Syn-Drum 70 69 118 0

SYNTH/
VARIOUS

071
GM REVERSE 
CYMBAL

GM RevCymbal 71 69 119 0

SYNTH/
VARIOUS

072 GM GT FRET NOISE GM GtFrNoise 72 69 120 0

SYNTH/
VARIOUS

073 GM BREATH NOISE GM BrthNoise 73 69 121 0

SYNTH/
VARIOUS

074 GM SEASHORE GM Seashore 74 69 122 0
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SYNTH/
VARIOUS

075 GM BIRD GM Bird 75 69 123 0

SYNTH/
VARIOUS

076 GM TELEPHONE GM Telephone 76 69 124 0

SYNTH/
VARIOUS

077 GM HELICOPTER GM Helicoptr 77 69 125 0

SYNTH/
VARIOUS

078 GM APPLAUSE GM Applause 78 69 126 0

SYNTH/
VARIOUS

079 GM GUNSHOT GM Gunshot 79 69 127 0

SYNTH/
VARIOUS

080 - 
127

User Tones 80 - 127 69

SYNTH/
VARIOUS

128 - 
129

User Tones 0 - 1 70

DRUMS 000 STANDARD SET 1 StandardSet1 0 125 0 120

DRUMS 001 STANDARD SET 2 StandardSet2 1 125 1 120

DRUMS 002 STANDARD SET 3 StandardSet3 2 125 2 120

DRUMS 003 STANDARD SET 4 StandardSet4 3 125 3 120

DRUMS 004 DANCE SET 1 Dance Set 1 4 125 26 120

DRUMS 005 DANCE SET 2 Dance Set 2 5 125 27 120

DRUMS 006 DANCE SET 3 Dance Set 3 6 125 28 120

DRUMS 007 TRANCE SET Trance Set 7 125 29 120

DRUMS 008 HIP-HOP SET Hip-Hop Set 8 125 9 120

DRUMS 009 ROOM SET Room Set 9 125 8 120

DRUMS 010 POWER SET Power Set 10 125 16 120

DRUMS 011 ROCK SET Rock Set 11 125 17 120

DRUMS 012 ELECTRONIC SET Elec.Set 12 125 24 120

DRUMS 013 SYNTH SET 1 Synth Set 1 13 125 25 120

DRUMS 014 SYNTH SET 2 Synth Set 2 14 125 30 120

DRUMS 015 JAZZ SET Jazz Set 15 125 32 120

DRUMS 016 BRUSH SET Brush Set 16 125 40 120

DRUMS 017 ORCHESTRA SET OrchestraSet 17 125 48 120

DRUMS 018 ETHNIC SET 1 Ethnic Set 1 18 125 49 120

DRUMS 019 ETHNIC SET 2 Ethnic Set 2 19 125 50 120

DRUMS
020 - 
039

User Drums 20 - 39 125

HEX 
LAYER

000 PX HEX TONE00 PX HexTone00 0 97

HEX 
LAYER

001 PX HEX TONE01 PX HexTone01 1 97

HEX 
LAYER

002 PX HEX TONE02 PX HexTone02 2 97

HEX 
LAYER

003 PX HEX TONE03 PX HexTone03 3 97

HEX 
LAYER

004 PX HEX TONE04 PX HexTone04 4 97

HEX 
LAYER

005 PX HEX TONE05 PX HexTone05 5 97

HEX 
LAYER

006 PX HEX TONE06 PX HexTone06 6 97

HEX 
LAYER

007 PX HEX TONE07 PX HexTone07 7 97

HEX 
LAYER

008 PX HEX TONE08 PX HexTone08 8 97

HEX 
LAYER

009 PX HEX TONE09 PX HexTone09 9 97

HEX 
LAYER

010 ICECASTLES Ice Castles 10 97

HEX 
LAYER

011 HOUSETOP House Top 11 97

HEX 
LAYER

012 MAXIMUM Maximum 12 97

HEX 
LAYER

013 MIDNIGHTSUN Midnight Sun 13 97

HEX 
LAYER

014 ORCHESTRA Orchestra 14 97

HEX 
LAYER

015 PX-PAD PX-Pad 15 97

HEX 
LAYER

016 ALORE YE Alore Ye 16 97

HEX 
LAYER

017 TRANSEDSAW Transed Saw 17 97

HEX 
LAYER

018 HEX SYNBRASS Hex SynBrass 18 97

HEX 
LAYER

019 HEX SYNVOICES HexSynVoices 19 97

HEX 
LAYER

020 HEX MFPIANO Hex Mf Piano 20 97

HEX 
LAYER

021 HEX JUNGLEPF Hex JunglePf 21 97

HEX 
LAYER

022 HEX BASIC EP1 Hex BasicEP1 22 97

HEX 
LAYER

023 HEX BASIC EP2 Hex BasicEP2 23 97

HEX 
LAYER

024 HEX BASIC EP3 Hex BasicEP3 24 97

HEX 
LAYER

025 HEX BASIC EP4 Hex BasicEP4 25 97

HEX 
LAYER

026 HEX BASIC EP5 Hex BasicEP5 26 97

HEX 
LAYER

027 HEX BASIC EP6 Hex BasicEP6 27 97

HEX 
LAYER

028 HEX ELEC.CLAV1 Hex EleClav1 28 97
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HEX 
LAYER

029 HEX ELEC.CLAV2 Hex EleClav2 29 97

HEX 
LAYER

030 HEX ENSEMBLE1 HexEnsemble1 30 97

HEX 
LAYER

031 HEX ENSEMBLE2 HexEnsemble2 31 97

HEX 
LAYER

032 HEX PIPE ORGAN HexPipeorgan 32 97

HEX 
LAYER

033 HEX SAX LAYER Hex SaxLayer 33 97

HEX 
LAYER

034 HEX WOOD LAYER HexWoodLayer 34 97

HEX 
LAYER

035 HEX REED LAYER HexReedLayer 35 97

HEX 
LAYER

036 HEX TOP OCTAVE HexTopOctave 36 97

HEX 
LAYER

037 HEX PICK LAYER HexPickLayer 37 97

HEX 
LAYER

038 HEX SPLIT1 Hex Split1 38 97

HEX 
LAYER

039 HEX SPLIT2 Hex Split2 39 97

HEX 
LAYER

040 HEX SYN-LEAD1 Hex SynLead1 40 97

HEX 
LAYER

041 HEX SYN-LEAD2 Hex SynLead2 41 97

HEX 
LAYER

042 HEX SYN-LEAD3 Hex SynLead3 42 97

HEX 
LAYER

043 HEX SYN-LEAD4 Hex SynLead4 43 97

HEX 
LAYER

044 HEX SYN-LEAD5 Hex SynLead5 44 97

HEX 
LAYER

045 HEX SYN-BASIC1 HexSynBasic1 45 97

HEX 
LAYER

046 HEX SYN-BASIC2 HexSynBasic2 46 97

HEX 
LAYER

047 HEX SYN-BASIC3 HexSynBasic3 47 97

HEX 
LAYER

048 HEX SYN-BASIC4 HexSynBasic4 48 97

HEX 
LAYER

049 HEX SYN-BASIC5 HexSynBasic5 49 97

HEX 
LAYER

050 - 
127

User HexLayer Tones 50 - 127 97

HEX 
LAYER

128 - 
199

User HexLayer Tones 0 - 71 98

ПРИМЕЧАНИЕ

yy Смотрите «Таблицу назначения клавишам клавиатуры 
тембров ударных инструментов» (стр. 46) для получе-
ния информации об ударных инструментах, назнача-
емых на каждую клавишу при выборе набора ударных 
инструментов («DRUMS»).
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STANDARD SET 1 STANDARD SET 2

C-1

D-1

E-1

F-1

G-1

A-1

B-1

C0

D0

E0

F0

G0

A0

B0

C1

D1

E1

F1

G1

A1

B1

C2

D2

E2

F2

G2

A2

B2

C3

D3

E3

F3

G3

A3

B3

C4

D4

E4

F4

G4

A4

B4

C5

D5

E5

F5

G5

A5

B5

C6

D6

E6

F6

G6

A6

B6

C7

D7

E7

F7

G7

A7

B7

C8

D8

E8

F8

G8

A8

B8

C9

D9

E9

F9

G9

C#-1

Eb-1

F#-1

Ab-1

Bb-1

C#0

Eb0

F#0

Ab0

Bb0

C#1

Eb1

F#1

Ab1

Bb1

C#2

Eb2

F#2

Ab2

Bb2

C#3

Eb3

F#3

Ab3

Bb3

C#4

Eb4

F#4

Ab4

Bb4

C#5

Eb5

F#5

Ab5

Bb5

C#6

Eb6

F#6

Ab6

Bb6

C#7

Eb7

F#7

Ab7

Bb7

C#8

Eb8

F#8

Ab8

Bb8

C#9

Eb9

F#9

STANDARD SET 4STANDARD SET 3 DANCE SET 1 DANCE SET 2 DANCE SET 3

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

Tabla Ge
Tabla Ka
Tabla Te
Tabla Na
Tabla Tun
Dholak Ge
Dholak Ke
Dholak Ta 1
Dholak Ta 2
Dholak Na
Dholak Ta 3
Dholak Ring
Mridangam Tha
Mridangam Dhom
Mridangam Dhi
Mridangam Dhin
Mridangam Num

High Q
Slap
Scratch Push
Scratch Pull
Sticks
Square Click
Metronome Click
Metronome Bell
Standard1 Kick 2
Standard1 Kick 1
Side Stick
Standard1 Snare 1
Hand Clap
Standard1 Snare 2
Low Tom 2
Closed Hi-Hat
Low Tom 1
Pedal Hi-Hat
Mid Tom 2
Open Hi-Hat
Mid Tom 1
High Tom 2
Crash Cymbal 1
High Tom 1
Ride Cymbal 1
Chinese Cymbal
Ride Bell
Tambourine
Splash Cymbal
Cowbell
Crash Cymbal 2
Vibraslap
Ride Cymbal 2
High Bongo
Low Bongo
Mute High Conga
Open High Conga
Open Low Conga
High Timbale
Low Timbale
High Agogo
Low Agogo
Cabasa
Maracas
Short High Whistle
Long Low Whistle
Short Guiro
Long Guiro
Claves
High Wood Block
Low Wood Block
Mute Cuica
Open Cuica
Mute Triangle
Open Triangle
Shaker
Jingle Bell
Bell Tree
Castanets
Mute Surdo
Open Surdo
Applause 1
Applause 2

Tablah 1
Tablah 2
Tablah 3
Daf 1
Daf 2
Riq 1
Riq 2
Riq 3
Davul 1
Davul 2
Zill 1
Zill 2
Ban Gu
Hu Yin Luo
Xiao Luo
Xiao Bo
Low Tang Gu
Mid Tang Gu
High Tang Gu
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�

�

�

�

�

�

�

�

�
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�

�

�

�

�

�

�

�

Standard2 Kick 2
Standard2 Kick 1
�

Standard2 Snare 1
�

Standard2 Snare 2
�

Standard2 Closed Hi-Hat
�

Standard2 Pedal Hi-Hat
�

Standard2 Open Hi-Hat
�

�

�
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�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Standard3 Kick 2
Standard3 Kick 1
Standard3 Side Stick
Standard3 Snare 1
Standard3 Hand Clap
Standard3 Snare 2
Standard3 Low Tom 2
Standard3 Closed Hi-Hat
Standard3 Low Tom 1
Standard3 Pedal Hi-Hat
Standard3 Mid Tom 2
Standard3 Open Hi-Hat
Standard3 Mid Tom 1
Standard3 High Tom 2
�

Standard3 High Tom 1
�

�

�

�

�

�

�

�

�

�

�

�
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�

�
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Standard4 Kick 2
Standard4 Kick 1
�

Standard4 Snare 1
�

Standard4 Snare 2
�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

�

Dance Kick 1
Dance Kick 2
Dance Kick 3
Dance Kick 4
Dance Kick 5
Dance Snare 1
Dance Snare 2
Dance Snare 3
Dance Snare 4
Dance Snare 5
Dance Snare 6
Dance Snare 7
Dance Snare 8
Dance Snare 9
Dance Tambourine
Hip-Hop Snare 4
Hip-Hop Snare 3
Techno Snare
Hip-Hop Rim Shot
Hip-Hop Snare 3 Rev.
Synth2 Kick 1 Rev.
Reverse Cymbal Gate
Hip-Hop Snare 4 Gate
Hip-Hop Snare 3 Gate
Techno Snare Gate
Hip-Hop Side Stick Gate
Hand Clap 2 Gate
�

�

Hip-Hop Scratch 1
Hip-Hop Scratch 2
�

�

�

�

Synth2 Kick 2
Synth2 Kick 1
�

Synth2 Snare 1
�

Synth2 Snare 2
Synth2 Low Tom 2
Synth2 Closed Hi-Hat 1
Synth2 Low Tom 1
Synth2 Closed Hi-Hat 2
Synth2 Mid Tom 2
Synth2 Open Hi-Hat
Synth2 Mid Tom 1
Synth2 Hi Tom 2
�

Synth2 Hi Tom 1
�

�

�

�

�

�

Synth2 Cymbal 2
�

Synth1 Kick 2
Synth1 Kick 1
Synth1 Rim Shot
Synth1 Snare 1
Synth1 Hand Clap
Synth1 Snare 2
Synth1 Low Tom 2
Synth1 Chh
Synth1 Low Tom 1
Synth1 Phh
Synth1 Mid Tom 2
Synth1 Ohh
Synth1 Mid Tom 1
Synth1 Hi Tom 2
Synth1 Cymbal
Synth1 Hi Tom 1
Synth1 Ride
Chinese Cymbal
Ride Bell
Synth 1 Tambourine
Splash Cymbal
Synth 1 Cowbell
Crash Cymbal 2
Vibraslap
Synth1 Kick 3
Hip-Hop Kick 3
Standard2 Kick 1
Standard2 Snare 1
Hand Clap 3
Standard2 Snare 2
Elec Low Tom 2
Hip-Hop Closed Hi-Hat
Elec Low Tom 1
Hip-Hop Pedal Hi-Hat
Elec Mid Tom 2
Hip-Hop Open Hi-Hat
Elec Mid Tom 1
Elec Hi Tom 2
Techno Cymbal
Elec Hi Tom 1
Techno Ride

Low Tom 2
Closed Hi-Hat
Low Tom 1
Pedal Hi-Hat
Mid Tom 2
Open Hi-Hat
Mid Tom 1
High Tom 2
Crash Cymbal 1
High Tom 1
Ride Cymbal 1

Tambourine 2
Tambourine 3
Cabasa 2
Maracas 2
Claves 2
Mute Triangle 2
Open Triangle 2
Shaker 2
Hand Clap
Hand Clap 2
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Hip-Hop Kick 3
Dance Kick 5
Hand Clap 3
Dance Snare 7
Hand Clap 2
Techno Snare
Synth2 Low Tom 2
Trance Closed Hi-Hat
Synth2 Low Tom 1
Trance Open Hi-Hat 1
Synth2 Mid Tom 2
Trance Open Hi-Hat 2
Synth2 Mid Tom 1
Synth2 High Tom 2
�

Synth2 High Tom 1
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Dance Kick 2
Dance Kick 4
Hip-Hop Side Stick Gate
Dance Snare 2
Synth1 Hand Clap
Dance Snare 1 Gate
Standard3 Low Tom 2
Standard3 Closed Hi-Hat
Standard3 Low Tom 1
Standard3 Pedal Hi-Hat
Standard3 Mid Tom 2
Standard3 Open Hi-Hat
Standard3 Mid Tom 1
Standard3 High Tom 2
�

Standard3 High Tom 1
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�

�

Клавиша Номер 
ноты

Таблица назначения клавишам клавиатуры тембров ударных инструментов

yy Символ « » означает тот же звук, что и в наборе «STANDARD SET 1».



47

Справочная информация

TRANCE SET HIP-HOP SET

C-1

D-1

E-1

F-1

G-1

A-1

B-1

C0

D0

E0

F0

G0

A0

B0

C1

D1

E1

F1

G1

A1

B1

C2

D2

E2

F2

G2

A2

B2

C3

D3

E3

F3

G3

A3

B3

C4

D4

E4

F4

G4

A4

B4

C5

D5

E5

F5

G5

A5

B5

C6

D6

E6

F6

G6

A6

B6

C7

D7

E7

F7

G7

A7

B7

C8

D8

E8

F8

G8

A8

B8

C9

D9

E9

F9

G9

C#-1

Eb-1

F#-1

Ab-1

Bb-1

C#0

Eb0

F#0

Ab0

Bb0

C#1

Eb1

F#1

Ab1

Bb1

C#2

Eb2

F#2

Ab2

Bb2

C#3

Eb3

F#3

Ab3

Bb3

C#4

Eb4

F#4

Ab4

Bb4

C#5

Eb5

F#5

Ab5

Bb5

C#6

Eb6

F#6

Ab6

Bb6

C#7

Eb7

F#7

Ab7

Bb7

C#8

Eb8

F#8

Ab8

Bb8

C#9

Eb9

F#9

POWER SETROOM SET ROCK SET ELECTRONIC SET SYNTH SET 1

0
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
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23
24
25
26
27
28
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30
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56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99

100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127
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Trance Kick 2
Trance Kick 1
Trance Side Stick
Trance Snare 1
Trance Hand Clap
Trance Snare 2
�

Trance Closed Hi-Hat
�

Trance Open Hi-Hat 1
�

Trance Open Hi-Hat 2
�
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Trance Tambourine
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Hip-Hop Kick 2
Hip-Hop Kick 1
Hip-Hop Side Stick
Hip-Hop Snare 1
Hip-Hop Hand Clap
Hip-Hop Snare 2
�

Hip-Hop Closed Hi-Hat
�

Hip-Hop Pedal Hi-Hat
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Hip-Hop Open Hi-Hat
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Room Kick 2
Room Kick 1
�

Room Snare 1
�

Room Snare 2
Room Low Tom 2
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Room Low Tom 1
�

Room Mid Tom 2
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Room Mid Tom 1
Room High Tom 2
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Room High Tom 1
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Power Kick 2
Power Kick 1
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Power Snare 1
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Power Snare 2
Room Low Tom 2
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Room Low Tom 1
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Room Mid Tom 2
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Room Mid Tom 1
Room High Tom 2
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Room High Tom 1
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Rock Kick 2
Rock Kick 1
Rock Side Stick
Rock Snare 1
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Rock Snare 2
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Rock Closed Hi-Hat
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Rock Pedal Hi-Hat
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Rock Open Hi-Hat
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Rock Crash Cymbal
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Rock Ride Cymbal
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Rock Splash Cymbal
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Elec. Kick 2
Elec. Kick 1
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Elec. Snare 1
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Elec. Snare 2
Elec. Low Tom 2
�

Elec. Low Tom 1
�

Elec. Mid Tom 2
�

Elec. Mid Tom 1
Elec. High Tom 2
�

Elec. High Tom 1
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Reverse Cymbal
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Synth1 Kick 2
Synth1 Kick 1
Synth1 Rim Shot
Synth1 Snare 1
Synth1 Hand Clap
Synth1 Snare 2
Synth1 Low Tom 2
Synth1 Closed Hi-Hat 1
Synth1 Low Tom 1
Synth1 Closed Hi-Hat 2
Synth1 Mid Tom 2
Synth1 Open Hi-Hat
Synth1 Mid Tom 1
Synth1 High Tom 2
Synth1 Crash Cymbal
Synth1 High Tom 1
Synth1 Ride Cymbal
�

�

Synth1 Tambourine
�

Synth1 Cowbell
�

�

�

Synth1 High Bongo
Synth1 Low Bongo
Synth1 Mute Hi Conga
Synth1 Open Hi Conga
Synth1 Open Low Conga
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Synth1 Maracas
�

�

�

�

Synth1 Claves
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SYNTH SET 2 JAZZ SET

C-1

D-1

E-1

F-1

G-1

A-1

B-1

C0

D0

E0

F0

G0

A0

B0

C1

D1

E1

F1

G1

A1

B1

C2

D2

E2

F2

G2

A2

B2

C3

D3

E3

F3

G3

A3

B3

C4

D4

E4

F4

G4

A4

B4

C5

D5

E5

F5

G5

A5

B5

C6

D6

E6

F6

G6

A6

B6

C7

D7

E7

F7

G7

A7

B7

C8

D8

E8

F8

G8

A8

B8

C9

D9

E9

F9

G9

C#-1

Eb-1

F#-1

Ab-1

Bb-1

C#0

Eb0

F#0

Ab0

Bb0

C#1

Eb1

F#1

Ab1

Bb1

C#2

Eb2

F#2

Ab2

Bb2

C#3

Eb3

F#3

Ab3

Bb3

C#4

Eb4

F#4

Ab4

Bb4

C#5

Eb5

F#5

Ab5

Bb5

C#6

Eb6

F#6

Ab6

Bb6

C#7

Eb7

F#7

Ab7

Bb7

C#8

Eb8

F#8

Ab8

Bb8

C#9

Eb9

F#9

ORCHESTRA SETBRUSH SET ETHNIC SET 1 ETHNIC SET 2
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57
58
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60
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62
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64
65
66
67
68
69
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71
72
73
74
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77
78
79
80
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82
83
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86
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93
94
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96
97
98
99
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105
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107
108
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111
112
113
114
115
116
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118
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122
123
124
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Номер Название вида
000 Screw Up
001 Screw Down
002 Panning Up
003 Filtering
004 Skip Up
005 Skip Down
006 Up Up Down
007 Down Down Up
008 Step Arp 1
009 Step Arp 2
010 Seq Lines
011 Synth Seq 1
012 Synth Seq 2
013 Seq Line 1
014 Seq Line 2
015 Seq Line 3
016 Seq Line 4
017 Seq Line 5
018 Seq Line 6
019 Seq Line 7
020 Prelude
021 Arp 2 Oct
022 9th Arp 1
023 9th Arp 2
024 9th Arp 3
025 Soul Bass 1

026 Soul Bass 2
027 Shuffle Bass
028 Funk Bass
029 Bossa Bass
030 8 Beat Bass
031 R&B Bass
032 Bass Line 1
033 Bass Line 2
034 Scale 1
035 Scale 2
036 Scale 3
037 Scale 4
038 Blues Scale
039 Penta Scale
040 Funky EP
041 Ragtime
042 Riff
043 Ska
044 8 Beat
045 12/8
046 Shuffle
047 Waltz
048 Shuffle Pop
049 Hard Rock
050 Echo
051 Trill

Номер Название вида
052 Poly 1
053 Poly 2
054 Poly 3
055 Poly 4
056 Poly 5
057 Poly 6
058 Poly 7
059 Poly 8
060 Up
061 Up 2Oct
062 Up 3Oct
063 Up 4Oct
064 Down
065 Down 2Oct
066 Down 3Oct
067 Down 4Oct
068 Up Down A
069 UpDownA 2Oct
070 UpDownA 3Oct
071 UpDownA 4Oct
072 Up Down B
073 UpDownB 2Oct
074 UpDownB 3Oct
075 UpDownB 4Oct
076 Random
077 Random 2Oct

Номер Название вида
078 Random 3Oct
079 Random 4Oct
080 Repeat 1
081 Repeat 2
082 Add 5th Up
083 Add 5th Down
084 Add 5th U/D
085 5th Up 1
086 5th Up 2
087 Octave Up 1
088 Octave Up 2
089 Octave Down
090 Poly Up
091 Poly Down
092 Poly Line
093 4th Up
094 4th Down
095 New Age
096 Gtr Strk 1
097 Gtr Strk 2
098 Latin Pf 1
099 Latin Pf 2

Номер Название вида

Номер Название вида
0 GrPiano1-L
1 GrPiano1-R
2 GrPiano2-L
3 GrPiano2-R
4 GrPiano3-L
5 GrPiano3-R
6 GrPiano4-L
7 GrPiano4-R
8 PianoAttack1
9 PianoAttack2
10 PianoAttack3
11 AiR E.Piano1
12 AiR E.Piano2
13 AiR E.Piano3
14 AiR E.Piano4
15 AiR 60’s EP1
16 AiR 60’s EP2
17 AiR 60’s EP3
18 AiR 60’s EP4
19 ElecPiano1 1
20 ElecPiano1 2
21 ElecPiano2 1
22 ElecPiano2 2
23 ElecPiano2 3
24 60’sE.Piano1
25 60’sE.Piano2
26 E.Grand 80
27 DynoE.Piano1
28 DynoE.Piano2
29 FM E.Piano
30 MelowEPiano1
31 MelowEPiano2
32 Digital EP1A
33 Digital EP1B
34 Digital EP1C
35 Digital EP2A
36 Digital EP2B
37 Digital EP2C
38 Digital EP3A
39 Digital EP3B
40 Digital EP3C
41 Digital EP4
42 Analog EP1
43 Analog EP2
44 EP Attack1
45 EP Attack2

46 EP Attack3
47 EP Attack4
48 EP Attack5
49 EP Attack6
50 EP Attack7
51 EP Attack8
52 EP Attack9
53 EP Attack10
54 EP Attack11
55 EP Attack12
56 Clavi 1 1
57 Clavi 1 2
58 Clavi 2 1
59 Clavi 2 2
60 Clavi Off
61 ClaviAttack1
62 ClaviAttack2
63 Harpsichord
64 Harpsi Off
65 CouplHarpsi
66 Vibraphone
67 GM E.Piano11
68 GM E.Piano12
69 GM E.Piano2
70 GM Harpsi.
71 GM Clavi
72 GM Celesta
73 GM Glocken.
74 GM MusicBox1
75 GM MusicBox2
76 GM Vibraphon
77 GM Marimba
78 GM Xylophone
79 GM TublarBel
80 Rock Organ 1
81 RockOrgan2 1
82 RockOrgan2 2
83 Rock Organ 3
84 JazzOrgan1 1
85 JazzOrgan1 2
86 JazzOrgan2 1
87 JazzOrgan2 2
88 Perc.Organ 1
89 PercOrgan2 1
90 PercOrgan2 2
91 PercOrgan3 1

Номер Название вида
92 PercOrgan3 2
93 Drawbar Org1
94 Drawbar Org2
95 Drawbar Org3
96 Elec.Organ 1
97 Elec.Organ 2
98 Elec.Organ 3
99 70’s Organ

100 OverdriveOrg
101 Tremolo Org
102 Click Organ
103 Organ Click
104 8’Organ1
105 8’Organ2
106 Seq.Organ1
107 Seq.Organ2
108 ChurchOrgan1
109 ChurchOrgan2
110 Chapel Organ
111 GM Organ 1
112 GM Organ 21
113 GM Organ 22
114 GM Organ 31
115 GM Organ 32
116 GMPipeOrgan1
117 GMPipeOrgan2
118 GM ReedOrgan
119 GMAccordion1
120 GMAccordion2
121 GM Harmonica
122 GMBandoneon1
123 GMBandoneon2
124 StreoString1
125 StreoString2
126 String Ens.
127 Slow Strings
128 BritStrings1
129 BritStrings2
130 Warm Strings
131 SynStrings11
132 SynStrings12
133 Syn-Strings2
134 Syn-Strings3
135 70’s Syn-Str
136 80’s Syn-Str
137 ViolnSect1

Номер Название вида
138 ViolnSect2
139 OrchestrPad1
140 OrchestrPad2
141 Choir1
142 Choir2
143 Synth-Voice1
144 Synth-Voice2
145 VoiceEnsemb1
146 VoiceEnsemb2
147 SynVoice Pad
148 BrassSect1
149 BrassSect2
150 Syn-Brass 11
151 Syn-Brass 12
152 Syn-Brass 21
153 Syn-Brass 22
154 80sSynBrass1
155 80sSynBrass2
156 Brass Ens.1
157 Brass Ens.2
158 BreathyASax1
159 BreathyASax2
160 BreathyASax3
161 BreathyTSax1
162 BreathyTSax2
163 BreathyTSax3
164 GM Violin
165 GM Viola
166 GM Cello
167 GM Contrabas
168 GM Trem.Str.
169 GM Pizzicato
170 GM Harp
171 GM Timpani
172 GM Strings 1
173 GM Strings 2
174 GM Syn-Str.1
175 GM Syn-Str.2
176 GM ChoirAahs
177 GM Voice Doo
178 GM Syn-Voice
179 GM Orch.Hit1
180 GM Orch.Hit2
181 GM Trumpet1
182 GM Trumpet2
183 GM Trombone

Номер Название вида

Перечень видов арпеджио

Перечень форм волны
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184 GM Tuba
185 GMMtTrumpet1
186 GMMtTrumpet2
187 GM Fr.Horn1
188 GM Fr.Horn2
189 GM Brass1
190 GM Brass2
191 GMSynBrass11
192 GMSynBrass12
193 GMSynBrass21
194 GMSynBrass22
195 GM Sop.Sax
196 GM Alto Sax
197 GM Tenor Sax
198 GM Bar.Sax
199 GM Oboe
200 GM Eng.Horn
201 GM Bassoon
202 GM Clarinet
203 GM Piccolo
204 GM Flute
205 GM Recorder
206 GM Pan Flute
207 GM BotleBlow
208 GMShakuhach1
209 GMShakuhach2
210 GM Whistle
211 GM Ocarina
212 AcousBass 11
213 AcousBass 12
214 AcousBass 13
215 AcousBass 21
216 AcousBass 22
217 AcousBass 23
218 Ride Bass
219 FingerBass 2
220 FingerBass 3
221 Picked Bass
222 Synth-Bass11
223 Synth-Bass12
224 Synth-Bass13
225 Synth-Bass14
226 Synth-Bass21
227 Synth-Bass22
228 Synth-Bass23
229 Synth-Bass24
230 Synth-Bass31
231 Synth-Bass32
232 Synth-Bass 4
233 Synth-Bass 5
234 Synth-Bass 6
235 Trance Bass1
236 Add FingBs1
237 Add FingBs2
238 Add FingBs3
239 Add PickBs1
240 Add PickBs2
241 Add SynBs1
242 Add SynBs2
243 Add SynBs3
244 SteelGuitr11
245 SteelGuitr12
246 Clean Guitar
247 Crunch E.Gt
248 OverdriveGt1
249 OverdriveGt2
250 Mute Ovd Gt
251 GM Nylon Gt1
252 GM Nylon Gt2
253 GM Steel Gt1
254 GM Steel Gt2
255 GM Jazz Gt
256 GM Clean Gt1
257 GM Clean Gt2
258 GM Mute Gt1
259 GM Mute Gt2
260 GMOverdrive1
261 GMOverdrive2
262 GM Dist.Gt
263 GM Gt Harm.
264 GMAcousBass1
265 GMAcousBass2
266 GMAcousBass3
267 GM FingerBs1
268 GM FingerBs2

Номер Название вида
269 GM PickBass1
270 GM PickBass2
271 GMFretlesBs1
272 GMFretlesBs2
273 GM SlapBass1
274 GMSlapBass21
275 GMSlapBass22
276 GM SynBass11
277 GM SynBass12
278 GM Syn-Bass2
279 Saw Lead 11
280 Saw Lead 12
281 Saw Lead 21
282 Saw Lead 22
283 Saw Lead 3
284 MelwSawLead1
285 MelwSawLead2
286 SquareLead11
287 SquareLead12
288 Square Lead2
289 PulseLead11
290 PulseLead12
291 PulseLead21
292 PulseLead22
293 Sine Lead
294 Sqr PulseLd1
295 Sqr PulseLd2
296 VA Synth 1
297 VA Synth 2
298 VA Synth 3
299 VA Synth 4
300 VA Synth 5
301 VA Synth 6
302 VA Synth 7
303 VA Synth 8
304 VA Synth 9
305 VA Synth 10
306 VA Synth 11
307 VA Synth 12
308 VA Synth 13
309 SequenceSaw1
310 SequenceSaw2
311 SawArpeggio1
312 SawArpeggio2
313 VA SynSeqBs1
314 VA SynSeqBs2
315 VA SynSeqBs3
316 Fantasy1
317 Fantasy2
318 New Age1
319 New Age2
320 Warm Pad
321 Warm Vox1
322 Warm Vox2
323 Syn-Bell Atk
324 SynVoice Atk
325 Syn-Pad1
326 Syn-Pad2
327 BrightSawPd1
328 BrightSawPd2
329 AtmspherePd1
330 AtmspherePd2
331 VA Syn-Pad 1
332 VA Syn-Pad 2
333 VA Syn-Pad 3
334 GM Squ.Lead1
335 GM Squ.Lead2
336 GM Saw Lead1
337 GM Saw Lead2
338 GM Calliope1
339 GM Calliope2
340 GMChiffLead1
341 GMChiffLead2
342 GM Charang1
343 GM Charang2
344 GMVoiceLead1
345 GMVoiceLead2
346 GMFifthLead1
347 GMFifthLead2
348 GMFifthLead3
349 GMFifthLead4
350 GMBass+Lead1
351 GMBass+Lead2
352 GMBass+Lead3
353 GMBass+Lead4

Номер Название вида
354 GM Fantasy1
355 GM Fantasy2
356 GM Warm Pad
357 GMPolySynth1
358 GMPolySynth2
359 GM SpaceCho1
360 GM SpaceCho2
361 GM BowGlass1
362 GM BowGlass2
363 GM MetalPad1
364 GM MetalPad2
365 GM Halo Pad1
366 GM Halo Pad2
367 GM Sweep Pad
368 GM RainDrop1
369 GM RainDrop2
370 GMSoundTrak1
371 GMSoundTrak2
372 GM Crystal1
373 GM Crystal2
374 GMAtmosphre1
375 GMAtmosphre2
376 GMBrightnes1
377 GMBrightnes2
378 GM Goblins1
379 GM Goblins2
380 GM Echoes
381 GM SF1
382 GM SF2
383 GM Sitar
384 GM Banjo
385 GM Shamisen
386 GM Koto
387 GM Thumb Pno
388 GM Bagpipe1
389 GM Bagpipe2
390 GM Fiddle
391 GM Shanai
392 GM Dulcimer
393 GM TinkleBel
394 GM Agogo
395 GMSteelDrum1
396 GMSteelDrum2
397 GM WoodBlock
398 GM Taiko
399 GM Melo.Tom
400 GM Syn-Drum
401 GM RevCymbal
402 GM GtFrNoise
403 GM BrthNoise
404 GM Seashore1
405 GM Seashore2
406 GM Bird1
407 GM Bird2
408 GM Telephone
409 GM Helicoptr
410 GM Applause1
411 GM Applause2
412 GM Gunshot
413 Sin Wave
414 SawtoothWave
415 Square Wave
416 Pulse Wave
417 White Noise
418 Pink Noise

Номер Название вида



51

Справочная информация

0 Blank Inst
1 Std1 Kick1
2 Std1 Kick2
3 Std2 Kick1
4 Std2 Kick2
5 Std3 Kick 1
6 Std3 Kick 2
7 Std4 Kick 1
8 Std4 Kick 2
9 HipHop Kick1
10 HipHop Kick2
11 HipHopKick3
12 Room Kick 1
13 Room Kick 2
14 Power Kick 1
15 Power Kick 2
16 Power Snare1
17 Power Snare2
18 Rock Kick 1
19 Rock Kick 2
20 Elec.Kick 1
21 Elec.Kick 2
22 Syn1 Kick 1
23 Syn1 Kick 2
24 Synth1Kick3
25 Syn2 Kick 1
26 Syn2 Kick 2
27 Syn2Kick1Rev
28 Trance Kick1
29 Trance Kick2
30 Dance Kick 1
31 Dance Kick 2
32 Dance Kick 3
33 Dance Kick 4
34 Dance Kick 5
35 Jazz Kick 1
36 Jazz Kick 2
37 Brush Kick 1
38 Concert BD
39 Std1 Snar1
40 Std1 Snar2
41 Std2Snare1
42 Std2Snare2
43 Std3 Snare 1
44 Std3 Snare 2
45 Std4 Snare 1
46 Std4 Snare 2
47 Room Snare 1
48 Room Snare 2
49 HipHopSnare1
50 HipHopSnare2
51 HipHopSnare3
52 HpHpSnar3Rev
53 HipHopSnare4
54 Rock Snare 1
55 Rock Snare 2
56 Elec.Snare 1
57 Elec.Snare 2
58 Syn1 Snare 1
59 Syn1 Snare 2
60 Syn2 Snare 1
61 Syn2 Snare 2
62 TranceSnare1
63 TranceSnare2
64 Dance Snare1
65 DanceSnar1Gt
66 Dance Snare2
67 Dance Snare3
68 Dance Snare4
69 Dance Snare5
70 Dance Snare6
71 Dance Snare7
72 Dance Snare8
73 Dance Snare9
74 Techno Snare
75 Jazz Snare 1
76 Jazz Snare 2
77 Brush Snare
78 Brush Slap
79 Brush Swirl
80 Concert SD

81 Side Stick
82 Std3SidStick
83 HpHpSidStick
84 RockSidStick
85 Syn1 RimShot
86 TrcSideStick
87 HpHp RimShot
88 BrshSidStick
89 Hand Clap
90 Std3HandClap
91 HipHpHndClap
92 Syn1HandClap
93 Trc HandClap
94 Hand Clap 2
95 Hand Clap 3
96 High Tom 1
97 High Tom 2
98 Mid Tom 1
99 Mid Tom 2

100 Low Tom 1
101 Low Tom 2
102 Std3HighTom1
103 Std3HighTom2
104 Std3MidTom1
105 Std3MidTom2
106 Std3LowTom1
107 Std3LowTom2
108 RoomHighTom1
109 RoomHighTom2
110 RoomMidTom1
111 RoomMidTom2
112 RoomLowTom1
113 RoomLowTom2
114 ElecHighTom1
115 ElecHighTom2
116 Elec.MidTom1
117 Elec.MidTom2
118 Elec.LowTom1
119 Elec.LowTom2
120 Syn1 HiTom1
121 Syn1 HiTom2
122 Syn1 MidTom1
123 Syn1 MidTom2
124 Syn1 LowTom1
125 Syn1 LowTom2
126 Syn2 HiTom1
127 Syn2 HiTom2
128 Syn2 MidTom1
129 Syn2 MidTom2
130 Syn2 LowTom1
131 Syn2 LowTom2
132 CloseHiHat
133 PedalHiHat
134 Open HiHat
135 Std2 CHHat
136 Std2 PHHat
137 Std2 OHHat
138 Std3 ClHiHat
139 Std3 PdHiHat
140 Std3 OpHiHat
141 HipHop CHHat
142 HipHop PHHat
143 HipHop OHHat
144 Rock ClHiHat
145 Rock PdHiHat
146 Rock OpHiHat
147 Syn1ClHiHat1
148 Syn1ClHiHat2
149 Syn1 OpHiHat
150 Syn2ClHiHat1
151 Syn2ClHiHat2
152 Syn2 OpHiHat
153 Trc ClsHiHat
154 Trc OpHiHat1
155 Trc OpHiHat2
156 CrashCymbal1
157 CrashCymbal2
158 RockCrashCym
159 ChineseCymbl
160 SplashCymbal
161 RockSplshCym

162 ReverseCymbl
163 Syn1CrashCym
164 TechnoCymbal
165 BrshCrshCym1
166 BrshCrshCym2
167 BrshSplshCym
168 RideCymbal 1
169 RideCymbal 2
170 Ride Bell
171 RockRideCymb
172 Syn1 RideCym
173 Techno Ride
174 BrshRideCym1
175 BrshRideCym2
176 BrshRideBell
177 Concert Cym1
178 Concert Cym2
179 High Q
180 Slap
181 Square Click
182 Sticks
183 Metron.Click
184 Metron.Bell
185 Scratch Push
186 Scratch Pull
187 HpHpScratch1
188 HpHpScratch2
189 Tambourin1
190 Tambourin2
191 Tambourin3
192 Syn1 Tambrin
193 TrcTambourin
194 DancTamborin
195 BrTambourn
196 Cowbell
197 Syn1 Cowbell
198 Vibraslap
199 High Bongo
200 Low Bongo
201 Syn1 HiBongo
202 Syn1LowBongo
203 Mute HiConga
204 Open HiConga
205 OpenLowConga
206 Syn1MtHiCong
207 Syn1OpHiCong
208 Syn1OpLoCong
209 High Timbale
210 Low Timbale
211 High Agogo
212 Low Agogo
213 Cabasa
214 Cabasa 2
215 Maracas
216 Maracas 2
217 Syn1 Maracas
218 ShrtHiWhistl
219 LongLoWhistl
220 Short Guiro
221 Long Guiro
222 Claves
223 Claves 2
224 Syn1 Claves
225 Hi WoodBlock
226 LowWoodBlock
227 Mute Cuica
228 Open Cuica
229 MuteTriangle
230 OpenTriangle
231 MuteTriangl2
232 OpenTriangl2
233 Shaker
234 Shaker 2
235 Jingle Bell
236 Bell Tree
237 Castanets
238 Mute Surdo
239 Open Surdo
240 Applause 1
241 Applause 2
242 Timpani F

243 Timpani F#
244 Timpani G
245 Timpani G#
246 Timpani A
247 Timpani A#
248 Timpani B
249 Timpani c+
250 Timpani c#+
251 Timpani d+
252 Timpani d#+
253 Timpani e+
254 Timpani f+
255 Tabla Ge
256 Tabla Ka
257 Tabla Te
258 Tabla Na
259 Tabla Tun
260 Dholak Ge
261 Dholak Ke
262 Dholak Ta 1
263 Dholak Ta 2
264 Dholak Na
265 Dholak Ta 3
266 Dholak Ring
267 MridangamTha
268 MridangmDhom
269 MridangamDhi
270 MridangmDhin
271 MridangamNum
272 Ban Gu
273 Hu Yin Luo
274 Xiao Luo
275 Xiao Bo
276 Low Tang Gu
277 Mid Tang Gu
278 High Tang Gu
279 Tablah 1
280 Tablah 2
281 Tablah 3
282 Daf 1
283 Daf 2
284 Riq 1
285 Riq 2
286 Riq 3
287 Davul 1
288 Davul 2
289 Zill 1
290 Zill 2

Номер Название вида Номер Название вида Номер Название вида Номер Название вида

Перечень тембров ударных инструментов
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